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ix

Introduction

This book is intended for users of Adobe Illustrator CS5. It describes the 
basics of linear perspective and discusses in detail the feature set available  
in Illustrator CS5 for drawing a scene in perspective.

Adobe Illustrator CS5 offers a completely new form of vector drawing— 
perspective or “3D-like” drawing. We were motivated to write this book 
because we wanted users to have enough background with perspective to 
take full advantage of the advanced features in Illustrator CS5. The scores of 
questions asked by prerelease testers of Illustrator CS5 confirmed that this 
training is needed.

Perspective drawing is a relatively specialized domain pursued by techni-
cal artists and draftsmen; while Illustrator caters to a wide array of profes-
sionals and hobbyists from traditional graphic designers and artists to web 
and interactive designers. With this book we have tried to bridge the gap 
between the two. By covering both linear perspective concepts and Illustra-
tor techniques, we have tried to make this book as self-contained as possible; 
however, basic understanding of Adobe Illustrator is assumed.

As the release of CS5 neared, we realized that the Illustrator Help or User 
Guide can introduce this new feature set to users, but it may not be enough 
to answer all the whys and wherefores that power users will inevitably ask! 
We have tried to provide useful tips and insights into implementation wher-
ever appropriate to provide a deeper understanding of the feature. We sin-
cerely hope that our endeavor enables new as well as experienced Illustrator 
users to quickly grab the concepts and use the tools and commands in a pro-
ductive, efficient, and creative manner. 
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1Introduction to 
Perspective

Our vision enables us to perceive the dimensions of objects we see around 
us: height, width and length, and depth or distance. This multidimension-
ality requires that when we draw a scene on a 2D surface such as canvas, 
we create a sense of depth so that objects in the scene have a look and feel 
resembling our perception. For ages humans have tried in various ways to 
depict real-world objects as realistically as possible. Perspective drawing 
is one technique that has been used for a few centuries now. It developed 
from two simple observations: first, that objects farther from the eye appear 
smaller than those closer to the eye; and second, that parallel edges tend to 
meet at one point.

Perspective drawing is based on orientation of the object with respect to 
the viewer. The orientation or placement of an object determines the use of 
one-, two-, or three-point perspective drawing to represent it on a flat can-
vas. Other factors to consider while drawing a perspective view of an object 
include the eye level, or the viewer’s height from ground level and the dis-
tance of objects from the viewer. Let’s investigate these basics of perspective 
before we see how they are implemented in Adobe Illustrator CS5.
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Basic Concepts
Perspective drawing is a technique used by artists to create a 3D appearance 
on a 2D surface. In other words, it’s a way to represent real-world objects on 
a flat surface such as paper or a computer screen. 

This technique is quite mature and is based on two simple observations 
about objects in the real world: Objects that are close to the viewer appear 
bigger than those farther from the viewer. This is known as diminution. And 
all the straight and parallel edges of a real-world object seem to meet at one 
point. This is known as convergence.

Illustrator CS5 allows one-, two- and three-point perspective drawing.

Figure 1.1 is a typical example of one-point perspective. Observe how the 
objects that are far from the viewer appear smaller than the ones that are 
closer; for example, the windows on the left side of the image are actually the 
same size, but as the distance from the viewer increases, the windows’ rela-
tive size decreases. Similarly, all the straight and parallel edges tend to meet 
at one point (this point is known as vanishing point in perspective drawing 
terminology). In this figure, the horizontal painted lines on the wall and the 
lines where the walls meet the floor all tend to meet at the vanishing point.

Figure 1.1 A typical exam-
ple of one-point perspective.
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In the two- and three-point perspective views, there are two and three van-
ishing points, respectively.

Figure 1.2 shows an example of two-point perspective, where two sides of 
the structure are visible but neither of them is squarely opposite the viewer. 
The visible sides of the of the building recede to the left and right.

In three-point perspective, a surface like a side of a building is seen to be 
simultaneously shrinking toward the left or right as well as upward or 
downward. There are two possible vantage points in a three-point perspec-
tive drawing: bird’s-eye view, and worm’s-eye view.

Bird’s-eye view is when the viewer is looking down at the image from above, 
as in a view of a city taken from an airplane (Figure 1.3).

Worm’s eye view is when the viewer is at the ground level and looking 
upward, as with a picture of a tall building taken from the road (Figure 1.4).

Figure 1.2 A real-world 
example of two-point per-
spective. You can see how 
the archways of the building 
and the supporting pillars 
recede into the distance, in 
two different directions.
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Figure 1.3 An example of 
bird’s-eye view.

Figure 1.4 An example of 
worm’s-eye view, where the 
wall and the bastion tend to 
vanish toward the sky.
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Terms and Definitions
Picture Plane: The flat surface on which the perspective drawing is done, 
such as the paper, canvas, or computer screen. Throughout this book we will 
frequently use the phrases parallel to the picture plane and perpendicular to the 
picture plane. A surface or plane that the viewer is facing directly is said to be 
parallel to the picture plane. A surface or plane which is at a 90-degree angle 
to the picture plane is said to be parallel to the picture plane.

Horizon Height: Also known as eye level, this is the height of the viewer’s 
eye from ground level. It determines how the viewer perceives the scene 
(Figures 1.5 and 1.6).

Figure 1.5 Higher eye 
level, or horizon height, 
leads to more area being 
visible. For example, in this 
figure the top face of the box 
is visible. The horizon line 
(the dotted line) is well above 
the top face.

Figure 1.6 Lower eye level, 
or horizon height, results in 
less area being viewable. For 
example, in this figure the 
top face of the box is not vis-
ible because the horizon line 
passes through the box itself.
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Vanishing Points: The imaginary points in a perspective drawing where 
a set of parallel edges tend to meet or converge. The number of vanishing 
points depends on where the object is placed in relation to the viewer.

For example, if a cube is placed so that only one of its faces is visible, and all 
four adjacent faces are perpendicular to the picture plane, then all the edges 
of the cube perpendicular to picture plane would tend to meet at one point, 
in one-point, or central, perspective (Figure 1.7).

Another typical example of one-point perspective is a railroad track; when 
one looks directly toward the track, the rails tend to vanish or join together 
at a distant point known as the vanishing point (Figure 1.8).

Figure 1.8 One-point perspective: 
The railroad tracks converge in the 
distance, at the vanishing point.  
Photo credit: Wikipedia

Figure 1.7 The dotted lines 
converge at the vanishing 
point.
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However, if the cube is placed so that none of its surfaces is directly fac-
ing the viewer’s sight line, both visible faces recede in different directions, 
which is known as two-point perspective (Figure 1.9).

Three-point perspective depicts objects viewed from high above, or tall 
objects viewed from well below their height. In three-point perspective, 
the cube is placed so that none of its edges is is directly facing the viewer 
(Figure 1.10).

Figure 1.9 Two-point  
perspective.

Figure 1.10 Object in 
three-point perspective, 
bird’s-eye view.
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Viewing Distance: Represents the distance between the viewer and the 
object in a drawing. When the viewing distance is greater, objects appear 
smaller, and vice-versa. Viewing distance also changes the relative dis-
tance between the left and right vanishing points in two- and three-point 
perspective.

Viewing Angle: Represents the orientation of the object in a drawing with 
respect to the picture plane. Simply put, it is the angle that the right face of a 
cube makes with the picture plane. Together with viewing distance, viewing 
angle is used to determine the location of vanishing points on the horizon 
line for two- and three-point perspective.

Station Point: Represents the location of the viewer in the drawing. Along 
with viewing angle it determines the orientation of the scene. The station 
point in a perspective drawing always lies on the ground line.

Determining the Location 
of Vanishing Points
Let’s take a look how to determine the location of vanishing points for each 
type of perspective. These concepts will help you create and work with the 
Perspective Grid presets that we introduce in the next chapter. This section 
is provided for the your information, but you don’t need to remember all the 
mathematics involved.

One-Point Perspective: For one-point perspective, the vanishing point 
and the station point both lie on the viewer’s line of sight—also known 
as the central line of vision. The vanishing point lies on the horizon line 
and the station point on the ground line. Figure 1.11 shows this in Adobe 
Illustrator CS5.

Hence the only parameter that plays a role in determining the vanishing 
point is the station point location for one-point perspective. The horizon 
height determines the position of the horizon line above the ground level.

Two-Point Perspective: Both the vanishing points lie on the horizon line. In 
the real world, the station point is always fixed (Figure 1.12). However, Illus-
trator CS5 allows you to move the station point, which lets you move vanish-
ing points independently (more on this later).
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Figure 1.11 The location of 
the vanishing point in one-
point perspective.

Figure 1.12 The top view 
(plan) and front view (eleva-
tion) of the imaginary cube 
and the parameters–viewing 
distance, viewing angle and 
horizon height—are used to 
establish the left and right 
vanishing points.
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Steps to Establish Vanishing Points
1. From the station point position in the top view, lines are drawn parallel 

to the edges of the imaginary cube.

2. These parallel lines meet the picture plane at the locations VP1 and VP2 
in Figure 1.12.

3. From VP1 and VP2, two straight lines are drawn perpendicular to the 
picture plane. These straight lines meet the horizon line in the front 
view at 4 and 5 in Figure 1.12, giving us the precise locations of left and 
right vanishing points. 

The angle shown in Figure 1.11 determines the relative positioning of the 
vanishing point with respect to the viewer’s line of sight. In Figures 1.13 and 
1.14, below, the same size cube is drawn at two different viewing angles. In 
Figure 1.13 the cube is oriented at 30 degrees; in Figure 1.14 the cube is ori-
ented at 60 degrees. The angle determines which face of the cube is more 
visible to the viewer.

Figure 1.13 The object is 
at an angle of 30 degrees, so 
the right face of the cube is 
more visible than the left.
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Both the vanishing points always make an angle of 90 degrees to the view-
er’s eye. Basic geometry shows that if the right face of the imaginary cube 
makes an angle α with the picture plane (what we refer to here as viewing 
angle) then the left face would make an angle of 90° – α.

The distance between the station point position and the picture plane 
determines the distance between vanishing points on the horizon line: the 
smaller the distance, the closer the vanishing points appear on the horizon 
line, and vice versa. It should be noted that close vanishing points don’t pro-
vide a realistic appearance, so vanishing points should be located at a ade-
quate distance from each other. In the following two perspective drawings, 
all the parameters that define perspective remain the same except for the 
viewing distance (or the distance between the picture plane and the viewer).

Three-Point Perspective: The method described above for two-point per-
spective is also used to determine two of the vanishing points in a three-
point perspective. The third vanishing point can be specified at some offset 
from the station point location. Illustrator lets you specify this offset, allow-
ing fine control over placement of the third vanishing point. See “Creating a 
Perspective Grid,” in the next chapter, to learn how to do this.

Figure 1.14 The object is 
at an angle of 60 degrees, 
so the left face of the cube is 
more visible than the right.
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Figure 1.15 This perspec-
tive drawing has a short 
viewing distance, so the 
vanishing points are close 
to each other on the horizon 
line, and the object has a 
somewhat distorted appear-
ance. This is sometimes used 
for dramatic effect, such as 
in a comic book.

Figure 1.16 This perspec-
tive drawing has a large 
viewing distance, so its van-
ishing points are far apart 
on the horizon line, and the 
object’s proportions appear 
more natural than those in 
Figure 1.15.
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2Perspective View in 
Illustrator CS5

The first step to perspective drawing is to decide on the perspective view 
and have it ready on the canvas. What this means in an application like 
Adobe Illustrator is to have some kind of static representation of perspective 
view in a document where user intends to create artwork.

Adobe Illustrator provides lots of flexibility for defining this static perspec-
tive view in a document. This includes powerful features such as defining 
individual parameters of a perspective numerically for complete accuracy, 
which is helpful when creating more technical illustrations. You can also 
quickly define perspective in a document by choosing one of the available 
presets, then start drawing.

Presets make the whole concept of perspective view even more useful in 
Illustrator, since you can easily create and save a perspective view and share 
it with others for reuse use it for working with multiple perspective views 
quickly, as we will demonstrate.

In addition to all this, Adobe Illustrator includes a tool to quickly manipulate 
the perspective completely based on interactive feedback, using newly intro-
duced tools such as the Perspective Grid Tool (Shift-P).

This chapter discusses these features in detail.
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Defining a Perspective View
To create any perspective drawing, you first must decide on the perspec-
tive view you want to draw: the orientation of the object, and the number 
of vanishing points. Then you choose the different parameters that define a 
perspective drawing. These parameters are location of vanishing points, eye 
level or horizon height, viewing distance, and viewing angle.

In Adobe Illustrator CS5 you can specify one-, two-, or three-point perspec-
tive for your drawing. The tools available for defining and manipulating a 
perspective grid let you create various perspective views pretty easily and 
change these to create different perspective drawings.

Every new Illustrator document has a default perspective view, which lets 
you start working with and understanding Illustrator’s perspective drawing 
system quickly.

The perspective view is represented in your document by an entity called 
the Perspective Grid. This Perspective Grid

• Is a visual representation of different perspective-defining parameters 
on the canvas

• Lets you interactively change the document’s perspective view in the 
document

• Helps in accurately creating shapes in perspective with precise 
dimensions

• Provides other drawing aids such as snapping, and rulers

Insight into Implementation

the Perspective Grid is not actually part of the document in which it is 
defined. It is drawn as annotation, like other annotations such as Smart 
Guides and the Gradient annotator in Illustrator. this means that although 
the perspective view is stored along with the document, these settings are 
used only for onscreen rendering of perspective view. any output form of the 
document (such as print or PDF) won’t have the Perspective Grid in it.
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As mentioned above, every new document in Illustrator has a default Per-
spective Grid (Figure 2.1), which is in two-point perspective. To make the 
default Perspective Grid visible, create a new document, and then choose 
View > Perspective Grid > Show Grid, or choose Cmd-Shift-I (Mac)/ Ctrl-
Shift-I (Windows), or select the Perspective Grid Tool from the Tools Panel 
(Shift-P).

Figure 2.1 Default Perspective Grid in a new Illustrator document.

The default grid is placed so that the horizon line is at the middle of the can-
vas. The Perspective Grid is a static entity, and once it has been defined, it 
retains its position until changed explicitly (using the Grid Movement wid-
get, which we will soon demonstrate). 

Illustrator allows only one Perspective Grid to be active in a document at 
any time. This may seem like a big limitation, but it keeps things simple. And 
you can work with multiple Perspective Grids in same document. Here’s the 
workaround:
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To work with multiple Perspective Grids in a document, simply define a grid 
using a Perspective Grid preset. After you finalize the grid parameters, espe-
cially the grid’s position, save the grid as a preset, draw objects on it. When 
you’re done, simply lock all the layers in the document to avoid changing the 
object later. Now define a different grid using some other preset, and follow 
the same process. if you wish to go back to the previous grid, simply lock the 
content drawn on the current grid, and switch to the previous preset. 

Creating a Perspective Grid
In addition to the default Perspective Grid in the document, there are two 
ways a user can define a custom Perspective Grid: using the Perspective Grid 
presets dialog, or using the Define Grid command.

Using Perspective Grid Presets
As with other Illustrator presets, you can create a new Perspective Grid pre-
set, which contains the information for defining a new perspective view 
in a document (Figure 2.2). To do this, choose Edit > Perspective Grid Pre-
sets, and click New. You can also edit an already created Perspective preset 
through this dialog. 

Figure 2.2 The Perspective 
Grid Presets dialog.
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To edit an existing preset click the Edit button. When an existing preset is 
selected in this dialog, the Preset Settings area lists the different parameters 
stored within the preset.

Like other presets in Illustrator, the Perspective Grid Presets can be 
imported from and exported to external files. In other words, you can cre-
ate a Perspective View, save it as a preset, and then pass it on as a stand-alone 
file to be used by another artist.

When you choose New or Edit from the Perspective Grid Presets dialog, the 
Perspective Grid Preset Options dialog appears (Figure 2.3).

Here is what each of these settings means.

Name: The name of the preset.

Type: The type of perspective view: one-, two-, or three-point perspective.

Units: The units to be used for measurements on the Perspective Grid. Note 
that this is not same as the document ruler unit. This unit is used while 
drawing objects in perspective and for displaying the dimensions of objects 
in places like Smart Guide Readout and Control Panel.

TIP  Default presets 
that come with Illustra-

tor appear in brackets and can-
not be edited or deleted.

Figure 2.3 The Perspective 
Grid Preset Options dialog.
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Scale: The scale factor. This gives a very flexible and powerful way to define 
a scale, so that scaled-up and scaled-down versions of real-world drawings 
can be easily created in Perspective. We will discuss how to use this option in 
Chapter 5, “Measurement Aids in Perspective.”

Gridline Every: The size of individual square cells in the grid being defined. 

Viewing Angle: The angle made between the eyeline of the viewer and the 
right face of an imaginary cube. This is applicable only for two- and three-
point perspective. Provide a value higher than 45 degrees if you want more 
drawing space between the station point and the left vanishing point. Enter 
a value less than 45 degrees to achieve the opposite. This value ensures that 
both the vanishing points are equally spaced from the station point.

Viewing Distance: The distance between the viewer and the picture plane; 
this is used for determining the location of the vanishing point. The higher 
the viewing distance, the farther apart the vanishing points will be, and 
vice-versa. The smaller the value here the sharper the perspective will be. 
It will feel like objects are very close to your eye. Use for dramatic effects in 
your drawing, such as for a comic strip. Most of the time you should enter a 
large enough value here to get a more realistic perspective.

Horizon Height: The viewer’s eye level, or the height of the viewer from the 
ground level. A higher value here implies that the scene is being drawn from 
a rooftop or a plane, so the scene will be much more detailed than a per-
spective with a lower horizon height value.

Third Vanishing Point X, Y: The offset values for specifying the location of 
the third vanishing point on the canvas. The offset values are taken from the 
station point location in perspective, which is always at ground level.

Grid Color and Opacity: Used for controlling the visual appearance of the 
Perspective Grid on the document. The color values are used for drawing 
different Perspective Grid planes; the opacity setting affects the whole grid.

Surprisingly, there is a difference between the Perspective Grid preset cre-
ated by choosing Edit > Perspective Grid Presets and one created by choosing 
Perspective > Save Grid as Preset (when a document is open). 

The Perspective Grid preset defined using the Edit > Perspective Grid Presets 
command doesn’t contain the absolute coordinate position used for drawing 

NOTE  For a detailed 
description about how 

these parameters are used for 
defining the Perspective View in 
the document refer to “Deter-
mining the Location of Vanish-
ing Points” in Chapter 1.

TIP  The Perspective 
Grid is a visual aid that 

always appears on top of your 
artwork. When you want to see 
more of your drawing and less 
of the grid, you can dim it by 
changing the Grid Opacity 
setting.
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the Perspective Grid. In other words, when this preset is used in a docu-
ment, the position of the Perspective Grid is based on the currently active 
artboard.

When a Perspective Grid is already defined and a preset is created from it 
with the Save Grid As Preset command, the absolute position of the Perspec-
tive Grid in the document is also stored. In other words, when this preset is 
used for defining a perspective in a new document, the grid is drawn at the 
same place as when preset was defined, independent of the currently active 
artboard.

This might be a little confusing, but it more it makes more sense if you con-
sider that when a preset is defined from pre-existing Perspective Grid, the 
grid’s absolute position is known and can be saved. However, when a preset 
is being defined independently of the document (using the Edit > Perspective 
Grid Presets command), there is no document to reference, so only the grid’s 
position relative to the active artboard can be saved.

Using the Define Grid Command
The second, and more direct, way to create a Perspective Grid in the docu-
ment is to choose View > Perspective Grid > Define Grid. This displays a 
dialog that’s similar to the one for Perspective Grid Presets; the difference is 
that the settings are directly applied to the current document and the grid is 
defined instead of getting stored in a new preset. 

If you already have a perspective grid defined in the document, then Define 
Grid can also be used to modify the current visual grid. You can also use the 
Define Grid dialog to save the currently defined grid as a preset.

Editing a Perspective Grid
Illustrator provides two ways to change the perspective view or the param-
eters of the Perspective Grid in your document: one for quick manipulation 
of Perspective Grid and another for providing precise numerical values for 
different parameters of the perspective.
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Using Perspective Grid Widgets 
for Interactive Editing
Illustrator CS5 introduces the new Perspective Grid tool (Shift-P) to interac-
tively modify the Perspective Grid and its different parameters in the docu-
ment (Figure 2.4). This is like on-canvas editing of perspective-defining 
parameters such as viewing angle, horizon height, and more. It is available 
in a completely new tool group that is devoted to Perspective Grid editing.

When you select the Perspective Grid tool, the currently defined Perspec-
tive Grid appears in the document, along with a lot of widgets, These wid-
gets (which look like either diamond- or circle-shaped handles) are used to 
manipulate different settings of the Perspective Grid.

Figures 2.5, 2.6, and 2.7 show each of the on-screen widgets for all three 
kind of Perspective Grid.

Figure 2.4 The Perspective 
Grid tool selected.

Figure 2.5 Widgets in a 
one-point perspective grid.
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The following is a legend for the letters in Figures 2.5, 2.6, and 2.7:

A. Vanishing point widget(s)

B. Horizon height widget(s)

C. Grid movement widget(s)

D. Plane widget(s)

E. Extent widget(s)

F. Cell size widget

G. Ruler origin widget

Figure 2.6 Widgets in a 
two-point perspective grid.

Figure 2.7 Widgets in a 
three-point perspective grid. 
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Below is a list of the types of widgets available to control the Perspective 
Grid. When Perspective Grid tool is selected and the mouse cursor is moved 
over the widget, the cursor changes to reflect the action allowed by that 
widget. For example, when the cursor is over the vanishing point in one- or 
two-point perspective, then it changes to two arrows representing the hori-
zontal movement of the vanishing point. This provides very clear feedback 
to the user about how a particular widget responds to the Perspective Grid.

Vanishing Point. Allows changing the position of the vanishing point on 
the horizon line. Note that except for the third vanishing point in three-
point perspective, vanishing points are restricted to movement along the 
horizon line. 

Horizon Height. These widgets change the eye-level of the viewer in the 
perspective view. These are available at both ends of the horizon line for 
easier access. The same setting can be changed numerically in the View > 
Perspective Grid > Define Grid dialog. A positive value for the horizon height 
represents a view from above ground level, and a negative value shows a 
view from below ground level.

Grid Movement. These widgets let you move the whole Perspective Grid 
anywhere on the canvas. Grid movement widgets are available at both ends 
of the ground line. This widget doesn’t have a counterpart in the View >Per-
spective Grid> Define Grid dialog; you have to use the widgets to change 
the Perspective Grid’s position. These widgets also represent the ground 
level of the perspective. The ground plane may be above or below this level; 
however, grid movement widgets always reside at the ground level and don’t 
move with the ground plane widget.

Plane Widgets. These let you control the movement and visibility states of 
the different planes in the perspective view. The number of these widgets is 
based on the number of planes available in Perspective View. For one-point 
perspective there would be two one for the ground plane and one for the 
vertical plane; for two- and three-point perspective there would be three 
widgets, one for the ground plane and two for the two vertical planes. When 
the mouse is moved over one of these widgets, the direction of movement 
is shown by the cursor change (Figures 2.8a and 2.8b). The corresponding 
plane can be moved to a new position using either the Perspective Grid tool 
or the Perspective Selection tool on these widgets.

NOTE  When the station 
point is locked, both van-

ishing points on the horizon line 
must move together; they can-
not be moved independently of 
each other. This is analogous to 
rotating an object on its verti-
cal axis. This is the technically 
correct way of changing the 
perspective because only the 
orientation of the object is 
changing. (You can verify this 
by checking the Viewing Angle 
field in the Define Grid dialog). 
But Illustrator does allow mov-
ing the vanishing points inde-
pendently—as long as the Lock 
Station Point setting is Off (to 
do this, deselect the command 
View > Perspective Grid > Lock 
Station Point). When you move 
one of the vanishing points on 
the horizon line in two- and 
three-point perspective (with 
Lock Station Point off), the 
application internally changes 
the viewing angle to 45 degrees 
and repositions the station 
point.
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Figure 2.8a Cursor change on vertical 
plane widget. 

Figure 2.8b Cursor change on ground 
plane widget. 

At times you may want to hide some part of the Perspective Grid; for exam-
ple, maybe you don’t want the left vertical plane to be visible in two-point 
perspective. For such situations, Illustrator lets you display the Perspective 
Grid plane in any of these visible states.

Completely Visible. The full plane along with the grid lines is visible. This 
widget is a double-dot circle.

Partially Visible. No grid lines on the plane are visible; instead, the plane 
area is filled with the color of the plane. In Figure 2.9, below, the left vertical 
plane of two-point perspective has been made partially visible. This widget 
is a colored circle.

Figure 2.9 Left vertical 
plane in partially visible 
state.
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Not Visible. Nothing about the plane is visible. In Figure 2.10, below, the left 
vertical plane is completely hidden. This widget is a single circle.

To switch among these three states, press Option (Mac) or Alt (Windows) and 
click the Perspective Grid or Perspective Selection tool (we’ll discuss why this 
works later).

Grid Extent. The grid extent widgets are used to control the visual appear-
ance of the Perspective Grid. The position of these widgets determines how 
much of the grid lines appears. Since lines and paths snap to these grid lines, 
it may be necessary to increase or reduce the number of perspective grid 
lines in a plane. There are two possibilities here with respect to grid line 
widgets:

• When the grid extent widget controls the nonvanishing dimension line: 
for example, with the extent widget on the vertical planes of one- and 
two-point perspective. The lines of the Perspective Grid are at constant 
distance from each other. In this case the lines would be drawn only up 
to where the widget is; this may involve drawing an incomplete cell in 
the end.

• When the grid extent widget controls vanishing dimension lines on the 
Perspective Grid: for example, with the extent widget on the ground 
plane of one-, two-, and three-point perspective, and with the widget 
on vertical planes of three-point perspective. In this case the lines of the 
Perspective Grid vanish. The extent of lines in this case is determined by 
two factors: the position of the widget and the document zoom level. 

Figure 2.10 Left vertical 
plane in invisible state. 

NOTE  The partially visi-
ble state of the Perspec-

tive Grid plane uses the same 
color as the plane color but 
with opacity of 20 percent to fill 
the plane region.

TIP  Since with this 
widget lines are drawn 

only to the location of the wid-
get, there may be cases when 
the last cell is not completely 
drawn. This may give the 
wrong impression about 
dimensions of a shape that you 
are drawing. If that happens, 
make sure the last cell is drawn 
completely.
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Insight into Implementation

the lines are drawn either up to the widget position or to the position the 
zoom level of the document permits.

In other words, while changing the position of this widget it may happen 
that lines are not drawn even though widget moves further towards the van-
ishing point, which is due to the zoom level of the document (since two lines 
have to be separately visible for drawing to take place). on the other hand 
if the zoom level permits, the lines would be drawn up to the widget position 
but never beyond it.

Cell Size. This can be used to move grid lines closer to or further from each 
other. This corresponds directly to the “Gridline every” setting in the View > 
Perspective Grid > Define Grid dialog. This value is useful while draw-
ing shapes that have sides of the same length, such as simple rectangles in 
perspective. This widget will not let you control the cell size value precisely 
since it doesn’t snap to anything. If you want a precise value for the cell size, 
use the Define Grid dialog instead of this widget.

Ruler Origin. The Perspective Grid has a complete ruler system in each of 
its planes, which will be discussed in detail in Chapter 5, “Measurement 
Aids in Perspective.” Although this widget lets you change the origin on the 
ground plane, you can click and drag it to other places in the ground plane. 
All the measurements then take care of the new origin in the plane. To reset 
the origin to its default location, simply double-click this widget and it will 
go to its default location, resetting the origin (Figure 2.11).

Figure 2.11 Ruler  
origin widget.

TIP  If you want to use 
a fairly dense grid for 

finer control, or if you are work-
ing at a higher zoom level, you 
can set the cell size to a smaller 
value. For less cluttered grid, 
choose a higher value for the 
grid cell size.
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The ruler origin will always be located at one of the intersection points of 
the grid lines on the ground plane. These two lines are represented by two 
dotted lines in gray, giving clear visual feedback about the position of the 
ruler origin.

Active Plane Widget. Most of the widgets for controlling the Perspective 
Grid are located on top of the grid itself. However one special widget is 
always located at a fixed position in the document window view and is very 
handy. It’s called the active plane widget, also known as the plane-switching 
widget. To understand its use we first need to understand the concept of an 
Active Plane in the Perspective Grid.

Every Perspective Grid has an active plane, which is one of the multiple van-
ishing planes (the left or right vertical plane or the ground plane) available 
in the Perspective Grid. You can also have no plane active. All operations—
including the creation of new shapes, bringing 2D objects into perspective, 
and snapping to perspective grid lines—are done using the currently active 
plane in the Perspective Grid. 

The current active plane determines the shape of the drawing created in 
perspective. In two-point perspective, if the left vertical plane is active, the 
rectangle will vanish only toward the left vanishing point; however, if the 
ground plane is active, the shape will vanish toward both vanishing points. 
Each active plane also has some offset associated with it, which basically rep-
resents the real-world distance between the station point and active plane. 
Chapter 6, “The Third Dimension,” discusses plane offset in detail.

The currently active plane in the Perspective Grid is indicated with a filled 
color in the active plane widget (Figure 2.12).

Figure 2.12 The icon 
indicates that the left verti-
cal plane is active in the 
Perspective Grid.

The No Plane Active state allows you to draw in two dimensions even if the 
Perspective Grid is visible, which allows some special workflows. You should 
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choose the No Plane Active state if you need to quickly work on objects not in 
perspective. For example, you might need to rotate a rectangle before bring-
ing it into perspective or draw a normal object such as the front face of a 
cube in one-point perspective.

Every Perspective Grid has an Active Plane widget. This widget is drawn at 
the top left of the document window’s view area by default. This ensures 
that you always have quick access to the widget. If needed, this widget can 
be moved to other three corners of document window view area. To do this, 
use the Perspective Grid Options dialog.

This widget allows changing the currently active plane in the Perspective 
Grid quickly. To change the currently active planes, simply move the mouse 
over (when one of the Perspective-aware tools is selected) the area repre-
senting the corresponding plane and click it to make that plane active. To 
deactivate all the planes or choose No Plane Active, simply click in the area 
outside the hexagon shape but within the plane-switching widget.

The widget provides pretty good feedback about the planes when mouse is 
moved over it, using the tool-tips (Figures 2.13a, 2.13b, 2.13c, and 2.13d).

Figures 2.13a and 2.13b Changing 
the active plane in a grid using the Plane 
Switching widget.

Figures 2.13c and 2.13d How to acti-
vate a plane using the Plane Switching 
widget.

There is another, quicker way to switch the currently active plane in the 
grid, using shortcut keys. Keeping one of the Perspective-aware tools 
selected, press 1 for left vertical plane, 2 for ground plane, 3 for right vertical 
plane), or 4 for no active plane.

Figure 2.14 The 
Perspective Grid Options 
dialog.

TIP  At times you may 
want to hide the Plane 

Switcher widget. It’s tempting 
to click the X at the top left of 
the plane widget, but clicking 
on it hides both the plane 
switcher widget and the Per-
spective Grid. If you simply wish 
to hide the plane switcher wid-
get or change its position, dou-
ble-click on either the 
Perspective Grid or the Perspec-
tive Selection tool to invoke the 
Perspective Grid Options 
dialog. 
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The Perspective Grid Options dialog lets you change the position and visibil-
ity of the Active Plane widget. We will discuss the options in the Automatic 
Plane Positioning area in Chapter 6, “The Third Dimension.”

Precise Grid Editing Using Numerical Inputs
The Perspective Grid can be edited using numerical inputs by choosing 
View > Perspective Grid > Define Grid. In the resulting dialog you can specify 
most of the perspective-defining values, including Horizon Height, View-
ing Distance, Viewing Angle, and “Grid line every.” There are some settings, 
however, such as ruler origin, ground level, and grid extent widget position 
that cannot be specified numerically. These can be edited only using the 
Perspective Grid tool. 

Setting the Perspective Grid
The Perspective Grid menu has number of options (Figure 2.15).

Figure 2.15 The 
Perspective Grid menu.

Hide/Show Grid. As the name suggests, this can be used for showing or 
hiding the grid. The keyboard shortcut Shift-Cmd-I (Mac)/Shift-Ctrl-I (Win-
dows) is much faster.

Hide/Show Rulers. When rulers are on, they are drawn on the vertical 
planes in the Perspective Grid. The rulers use the ruler origin position on 
the ground plane as well as any scale value defined for the Perspective Grid. 
There are other, more useful ways to view and control measurements such 
as Readouts, the Info Panel, and the Control Panel. We will discuss these in 
detail in Chapter 5.
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Snap to Grid. This enables snapping to Perspective Grid lines. Snapping is 
available for object creation and transformation of objects in perspective. 
When Snap to Grid is disabled, objects can be created and transformed 
freely anywhere on the grid.

Lock/Unlock Grid. At times you may not want to change the Perspective 
View once it is properly set up, in which case locking the grid comes in 
handy. If the grid is locked, only the Grid Plane’s position and visibility can 
be changed using the Perspective Grid tool.

Lock/Unlock Station Point. When the station point is locked, if you try to 
move one vanishing point on the horizon line in a two- or three-point per-
spective, then the other vanishing point also moves. This ensures that the 
vanishing points on the horizon line always make an angle of 90 degrees 
to the viewer’s eye. When the station point is not locked, you can move the 
vanishing points on the horizon line freely, but then the station point itself is 
adjusted by the application.

Define Grid: This invokes the Define Grid dialog for defining or changing 
the current grid in a document.

One/Two/Three Point Perspective: This lists all the perspective presets 
available based on the perspective type. This provides quick access to all the 
available presets in a logical manner. Choosing one of these presets replaces 
any other already defined grid).

Save Grid As Preset: This starts the same UI dialog as for Define Grid; how-
ever, this time the settings are saved in a new preset instead of being directly 
applied to the current document.
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3Creating Content in 
Perspective

You can actually start drawing in perspective right after you have finalized 
your perspective view (that is, after you have chosen the appropriate Per-
spective Grid and tweaked its settings as needed).

There are multiple ways to draw objects in perspective, which depend com-
pletely on how you visualize your object in perspective. If you’re drawing a 
simple shape such as a rectangle or star, you might want to draw it in per-
spective from the outset. For something more complex, drawing in 2D space 
first and then bringing it into perspective might be easier. If you have a 
complex shape that you simply want to make vanish in perspective, you can 
achieve that by attaching existing shapes directly to your perspective view.

The tools in Adobe Illustrator give you freedom to draw objects in perspec-
tive all three ways mentioned above. To create an attractive perspective 
drawing you’ll usually need to combine all three methods. This chapter 
explores these methods, using examples.

Drawing Shapes in Perspective
These are the tools provided by Illustrator CS5 for drawing shapes directly 
in perspective. These support workflows where you are thinking about the 
objects directly in perspective at the time of drawing (Figure 3.1).
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Figure 3.1 Tools avail-
able for drawing basic 
shapes in perspective.

When you draw a shape using one of these tools (except for the Flare tool) 
keeping the Perspective Grid visible, the shape is drawn in perspective. If 
you draw a rectangle, it is drawn in perspective and takes the shape of a 
trapezoid (Figure 3.2).

The new shape is drawn on the currently active plane of the Perspective 
Grid. The active plane can be changed using keyboard shortcuts or the 
Active Plane widget. 

There may be times when you need to draw a shape in perspective and draw 
some 2D shapes as well. For example, you might draw the top and front face 
of a cube in one-point perspective, where the front face is a normal rectan-
gle and the top face is in the floor plane of perspective (Figure 3.3). This can 
be easily achieved by setting the active plane of the Perspective Grid to No 
Active Plane using the plane switcher widget or the keyboard shortcut 4.

Figure 3.2 Creation 
of a simple rectangle in 
perspective.
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The readouts that show the dimensions of the shape represent the real-
world dimension of the shape (also honoring the specified scale factor 
defined in the Perspective Grid). This provides a very powerful and flexible 
way to create technical drawings in perspective. For details see Chapter 5, 
“Measurement Aids in Perspective.”

When creating shapes you can also specify the real-world dimensions of 
objects, and they are handled appropriately in perspective. This is use-
ful while drawing a scaled down or up version of a technical drawing in 
perspective.

When working in perspective you can use the shortcuts that are available 
for creating basic shapes in Illustrator, such as creating a rectangle starting 
from the center by pressing the Alt key in Windows or Option on the Mac. 

To quickly make minor transformations to an object, such as scaling it, 
you can press Ctrl (Windows) or Cmd (Mac) with the relevant tool selected 
and the Perspective Grid visible. This temporarily changes the tool to the 
Perspective Selection tool, which makes any transformation work in per-
spective. There are more details about perspective transformation in next 
section. While using Ctrl/Cmd to switch to the Perspective Selection tool, 
make sure the Perspective Grid is visible; otherwise, you might end up 
switching to normal selection, and the transformation done on the shape 
will not be in perspective.

Figure 3.3 Cube in one-
point perspective. The front 
face is created by choosing 
the No Plane Active state.
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Snapping Aids for Drawing  
Shapes in Perspective
For accurate technical drawing and drawing shapes in alignment with 
already drawn shapes, there are two forms of snapping available, snapping 
to the Perspective Grid and snapping to perspective construction guides.

Snap to Perspective Grid
By default, Snap to Perspective Grid is enabled. (The command to enable or 
disable it is accessible via View > Perspective Grid > Snap to Grid). With Snap 
to Perspective Grid on, the mouse cursor snaps to grid lines of the currently 
active plane. If Smart Guides are on, the user is also given visual feedback in 
the form of text labels including On and Intersect (when the mouse is on the 
intersection of two grid lines). This provides a very useful way to create basic 
shapes accurately.

Snap to Perspective Construction Guides
When Smart Guides are enabled, automatic guides are generated from the 
anchor point of the objects. The guides are called construction guides: In nor-
mal 2D drawing these guides are generated at specified angles (depending 
on your preferences). With perspective objects, these construction guides 
are always generated toward the vanishing points. To start generating con-
struction guides in perspective you have to move the mouse temporarily to 
any anchor point of a perspective object. This is useful when drawing shapes 
in perspective in alignment with already-drawn shapes.
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Insight into Implementation

the tolerance for Snap to Perspective grid is one-fifth of the grid cell size (the value available in the Define 
grid dialog). note that snapping works in perspective; that is, the snapping tolerance is automatically 
adjusted to account for cells that shrink as they approach the vanishing point, ensuring that the tolerance 
remains one-fifth of the cell size throughout the Perspective grid. this is very helpful while drawing shapes 
at any location in perspective. one might wonder why the snap tolerance here is not half of the grid cell size 
and why it is not always snapping to grid lines. there are two reasons not to have a snap tolerance of half 
the grid cell size:

• it allows drawing without snapping to Perspective grid lines between the grid lines, even without turning 
off Snap to grid.

• it allows better snapping behavior since one can snap to both Perspective grid lines and the Perspective 
Construction guide together, again even when Snap to grid is on.

• another point to note is snapping of perspective shapes when they are moved. the boundaries of the 
shapes in perspective are snapped to Perspective grid lines (Figure 3.4).

Figure 3.4 Snapping to Perspective Grid lines.
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As soon as you mouse over an anchor point, you see “anchor” written on the 
canvas (Figure 3.5). Doing this registers this anchor point for generating the 
perspective construction guides.

Now when you move the cursor, guides are generated automatically start-
ing at the registered point (the anchor point). The guides are generated (and 
snapped to) based on the type of perspective. In a one-point perspective 
grid, the guides are generated toward the vanishing point—one vertical and 
one horizontal guide.

Likewise, in a two-point perspective drawing, guides are generated toward 
both the vanishing point and in a vertical direction. For three-point per-
spective, the guides are generated toward all three vanishing points. In 
other words, guides are generated for all three dimensions.

In Figure 3.6 the construction guides are generated from the top edge of the 
first window on the right wall.

Figure 3.5 Registering  
an anchor point to start  
generating perspective  
construction guides.
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Imagine that you want to draw a window that lines up with ones that are 
already drawn. All you need to do is register a top edge anchor point and a 
bottom edge anchor point before beginning to draw the window. This gen-
erates appropriate guides (Figures 3.6 and 3.7).

Figure 3.6 Starting a new 
shape with the help of per-
spective construction guides.

Figure 3.7 Creating an 
aligned shape using perspec-
tive construction guides.



ptg

PerSPeCtive-aware toolS 37

TIP  Another good use of this kind of snapping is to duplicate a simple shape. For exam-
ple, if you create a simple rectangle in perspective and then snap to one of the Construc-

tion Guide toward a vanishing point, you only need to click to open the dialog for creating a 
rectangle, then press Enter. This creates a rectangle of the same size, in alignment and in per-
spective (Figure 3.8).

Remember that even if construction guides are turned off in the Smart 
Guide preferences, the Perspective Construction guides would continue to 
generate whenever Smart Guides are on.

Perspective-Aware Tools
For convenience, we can informally refer to the set of tools that work in  
perspective collectively as perspective-aware tools. This includes:

1.  Tools in the Line Segment group, including Line, Arc, Spiral, and 
Rectangular/Spiral Grid

2.  Tools in the Rectangle group, including. Rectangle, Rounded Rectangle, 
Ellipse, Polygon and Star

3.  The Perspective Selection tool

Figure 3.8 Using perspec-
tive construction guides to 
create a similar-size shape in 
alignment.

TIP  We recommend 
that you keep Smart 

Guides on (enable this option 
by choosing View > Smart 
Guides) while working with the 
Perspective Grid. They provide 
pretty good visual feedback 
and are very useful while snap-
ping or working with automatic 
plane positioning (discussed 
later).

You may wish to customize the 
settings for Smart Guides to 
suit your needs (choose Edit > 
Preferences > Smart Guides).
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All of these tools work in perspective only when the Perspective Grid is vis-
ible in the document, with the exception of the Perspective Selection tool, as 
we will discuss later. 

Drawing in Normal 2D Space Then 
Bringing Objects Into Perspective
Up to this point we have seen how to create shapes directly in perspective. 
There is another way to create shapes in perspective—by drawing them in 
normal 2D space and then bringing them into perspective with the Perspec-
tive Selection tool. This is useful when you are designing everything in 2D 
space and you want to bring them together in perspective.

This workflow is very simple: Draw the shapes in normal 2D space, making 
sure Perspective Grid is either not visible or is in the No Plane Active state. 
This ensures that you don’t accidentally draw your shapes in perspective. 
When you’ve finished drawing, make the Perspective Grid visible and that a 
plane is active. Choose the Perspective Selection tool and use it to drag the 
2D object into perspective. The shape then changes its appearance to reflect 
that it is now in perspective (Figure 3.9).

TIP  The Pen tool 
doesn’t really work in 

perspective. It does snap to the 
Perspective Grid lines, however, 
which could be misleading. The 
snapping to Perspective Grid 
lines merely helps you create 
shapes. If you want to trans-
form a shape you’ve drawn in 
perspective with the Pen, it 
must be brought into perspec-
tive using the “Attach to active 
plane” command. See the sec-
tion “Attach Objects to Perspec-
tive,” later in this chapter, for 
more information.

Figure 3.9 Bringing 
2D objects into perspec-
tive using the Perspective 
Selection tool.
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You can bring in a copy of an existing object by using the Alt (Windows) or 
Option (Mac) key while using Perspective Selection tool.

When bringing flat objects in this way, you can also change the current 
active plane on the Perspective Grid, using previously described shortcuts; 
that change is reflected in the change in shape of the object being dragged.

This changing of planes while bringing objects into perspective is pretty 
useful while creating an illustration based on the elevation and plan view 
of a drawing. One can simply start dragging one of these projections and 
change the plane dynamically during placement.

One thing is important to know about this workflow, though. Objects that 
are brought into perspective cannot be reverted back to their original shape, 
If you bring a rectangle into perspective, it changes to look like a trapezoid, 
and you can’t turn it back into a rectangle, unless you Undo (Figure 3.10).

Figure 3.10 Once they are 
brought into perspective, 
objects cannot be trans-
formed back into their 2D 
shapes.

There are two ways to work around not being able to return to the original 
object from a perspective object:

• You can copy your 2D object while bringing it into perspective, by press-
ing the Alt (Windows) or Option (Mac) key while dragging with the Per-
spective Selection tool.
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• You can turn the 2D shape into a symbol, and then place it in perspec-
tive. This offers the great flexibility of letting you change the symbol 
definition, which is reflected in the perspective instance of the shape. 
See Chapter 7, “Working with Text and Symbols in Perspective,” for 
details.

There are two reasons why reverting to the original shape from a perspec-
tive object is not allowed:

The position of the object in perspective might be too far away from the 
station point and the restored object could fall completely out of document 
canvas area. In other words objects that are very close to the vanishing point 
are theoretically very far from the viewer, so restoring such an object could 
cause the original to be off the canvas.

The second and more important reason is the size of the object. Objects 
closer to the vanishing point may appear very small, but the dimensions of 
original object may be huge. The dimensions of the original object may not 
fit within the view or even the canvas.

Art Types that Cannot Be 
Brought into Perspective
Types of art that cannot be brought into perspective include raster images, 
gradient mesh, envelope, and non-native art. Even if you create an envelope 
or a gradient mesh out of objects in perspective, you cannot further move or 
scale those with the Perspective Selection tool. Admittedly, these are some 
of the most useful features of Illustrator. We will show you a workaround to 
overcome these limitations. 

In this example I want to place the gradient mesh object on the top right 
corner of my artboard on the right grid (Figure 3.11). Since you cannot do so 
with the Perspective Selection Tool, do the following:

1.  Draw a rectangle in perspective on the right grid of your desired size 
and at your desired position.
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2.  Select the rectangle in perspective and the gradient mesh object, and 
use the command Object > Envelope Distort > Make with Top Object 
to create an envelope that makes the mesh appear in perspective. 
One problem with this work-around is that after this step you cannot 
move the rectangle in perspective.

The fill applied to objects in perspective doesn’t honor the perspective 
direction. For a solid fill it will not matter at all; however, if you have a pat-
tern or gradient swatch on an object, the fill will not use the perspective on 
the object.

Flat Objects on Canvas Versus 
Objects in Perspective
This section explains how measurements in perspective relate to mea-
surements on canvas, irrespective of the way you create perspective art-
work—whether by dragging using the drawing tools, bringing flat objects 
into perspective with Perspective Selection tool, or drawing using numeric 

Figure 3.11 Placing a gra-
dient mesh into perspective 
using the Envelope Distort 
technique.
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inputs. To keep things simple, illustrations are created with the one-point 
grid system only. The concepts can be easily extended to the higher-order 
perspective grids.

We already know that we can incorporate a scale in the grid preset. Scale will 
be elaborated on further in Chapter 5, “Measurement Aids in Perspective.”

For the sake of simplicity, let us assume a scale of 1:1. The distance between 
gridlines (the “Gridline every” value in the Define Grid dialog) in the grid 
used in the following illustrations is equal to 1 inch, so that each grid cell 
represents a 1-inch by 1-inch square. 

A 4-inch-long horizontal straight line drawn on canvas and projected at 
multiple positions on the floor and vertical planes will always occupy 4 
grid divisions, each grid division being 1 inch. Notice how the absolute 
length changes depending on the plane and the location of the straight line 
(Figure 3.12).

Likewise, a 4-inch-long vertical straight line, projected onto vertical and 
floor planes, is always equal to 4 vertical grid divisions. The absolute length 
again depends on the position on the grid (Figure 3.13).

Figure 3.12 Projection of a 
horizontal line in perspective 
planes.
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Extending this projection concept further, the diagonal line—a 1-inch-by-1-
inch square drawn on canvas—always gets projected as a diagonal of a grid 
cell on either the vertical or the ground plane of a grid, with grid cell size 
being 1 inch by 1 inch (Figure 3.14).

Figure 3.13 Projection of 
a vertical line in perspective 
planes. 

Figure 3.14 Projection 
of a diagonal of 1-by-1-inch 
square on perspective 
planes.
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Likewise, a 5-inch-long straight line at an angle of tan-1 (¾), which is roughly 
37 degrees, will connect the corners of a block of 3 cells by 4 cells block. 
Remember Pythagoras?

Now that you understand the concepts of projecting straight lines onto 
perspective grid planes, it’s fairly easy to extend the concept to 2D shapes. 
For example, a 3-inch-by-4-inch rectangle covers exactly 3 by 4 cells on any 
grid plane (Figure 3.15). For any irregular shape, it is as if the rectangular 
bounding box of the object as seen on the canvas is projected onto a plane.

Attaching Objects to Perspective
You may need to create irregular shapes directly in perspective. For exam-
ple, you might want to draw a curved portion of a window directly in per-
spective using the Pen tool. If you do this and use the Perspective Selection 
tool to bring the drawn window into perspective, the appearance of the 
window will changed, since it will be projected into perspective.

But what you really want is to keep the appearance of the window, and 
simply make sure it recedes toward the vanishing point, as it is when trans-
formed using the Perspective Selection tool.

Figure 3.15 Projection of 
a regular shape on perspec-
tive planes.
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To achieve this you can simply draw a shape a free-form shape as you usually 
would in 2D, using the Pen or any other appropriate tool; then, from Object 
context menu, choose Perspective > Attach to Perspective. You can perform 
the same action using the Object > Perspective > Attach to Active Plane com-
mand. This action attaches the object to the currently active plane in the 
Perspective Grid. If you want to attach the object to some other plane, before 
using this command you need to change the active plane. You can do that 
by switching to the Perspective Selection tool and changing the active plane 
using the shortcuts previously described.

This assumes that the object is in perspective as drawn and won’t change in 
shape. It ensures that the object vanishes as it is transformed using the Per-
spective Selection tool.

The irregular shape in Figure 3.16 was drawn using the normal Pen tool. 
You can right-click the completed object to open the context menu, from 
which you can choose Perspective > Attach To Active Plane.

Figure 3.16 Bringing an irregular shape into perspective.



ptg

ChaPter 3: Creating Content in PerSPeCtive46

The object is now in perspective: Any transformation using the Perspective 
Selection tool will be in perspective. For example, in Figure 3.17 we have 
duplicated the object, and the copy also appears in perspective.

Insight into Implementation

in all three ways of drawing in perspective, the object in perspective stores 
extra information. the information is basically about the plane (left, right, 
ground) on which the object belongs. this information is used by differ-
ent operations in perspective, such as getting the bounding box and other 
transformations. this information remains with the object until the object is 
released from the perspective.

Editing Objects in Perspective
Objects drawn or brought into perspective retain their base art-type prop-
erties (except for the text and symbols, as we’ll discuss later), and you can 
edit them freely. Illustrator assumes that the edited shape is still in perspec-
tive; editing objects does not change that. For example, when you bring a 

Figure 3.17 Irregular 
shapes copied in perspective.
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rectangle into perspective it takes the shape of a trapezoid. If you then move 
one of its anchor points using the Direct Selection tool, the new shape is 
considered to still be in perspective, even though the Direct Selection tool 
has effectively changed the shape of the original rectangle itself.

Figure 3.18 shows a normal rectangle that has been placed into perspective, 
then the top right anchor point was moved a little bit. Now if you tried mov-
ing this changed shape using the Perspective Selection tool, it would start to 
vanish in perspective. In other words, the new shape is still in perspective 
even though it was edited with a tool that is not perspective aware.

It’s easy to infer that you can use many other tools and transform operations 
that affect an object’s appearance but don’t take it out of perspective, such as 
rotating the object using the normal bounding box.

Release with Perspective
We saw in the last section that operating on an object in perspective does 
not really take it out of perspective; there may be times when you wish the 
object to be removed from perspective. That’s why the Release with Perspec-
tive command is available from the context menu, by choosing Object > 
Perspective.

Figure 3.18 Edited objects 
remain in perspective.
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Basically, Release with Perspective does the exact opposite of Attach to Active 
Plane. As we saw, Attach to Active Plane lets you use the Pen or Pencil tool to 
draw nonprimitive shapes (those other than rectangles, ellipses, and poly-
gons) that already appear to be in perspective, which you can then trans-
form in perspective without distorting their shape or appearance.

Release with Perspective may come in handy if you are unable to move an 
object in perspective with the Perspective Selection tool because of its posi-
tion relative to the grid. This can happen if, for example, when objects are 
drawn across a vanishing point and then attached to a plane (since these are 
not valid objects in perspective), or in the case of an object copied and pasted 
object from a different document (which remembers its association with the 
plane). Of course you can always move such objects with the regular Selec-
tion tool. Release with Perspective may also be useful when you need to use 
two different grids in the same illustration. You may choose to release all 
objects drawn on the first grid to avoid their transformation such as Shift-
drag, or by accident while working on another grid in the document.

Figure 3.19 Releasing an 
object from perspective.
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4Transformations in 
Perspective

Now that you are aware of setting the Perspective View/Grid and creating 
artwork in perspective different ways, the next step is transforming objects 
in perspective.

This is where the Perspective Selection tool comes into play: It doesn’t just 
select the objects in perspective (as the name suggests), but also handles 
some basic transformations including movement, scaling, and movement 
through planes (perpendicular movement).

For transformations in perspective you need to use Perspective Selection 
tool. Of course, for transformations that are not available in perspective, 
such as rotation, you can always make the transformation in the flat (2D) 
version of the object, and then use the Perspective Selection tool to put it 
into perspective. This allows all the transformations to work in perspective 
either directly (using the Perspective Selection tool) or indirectly.

The upcoming discussion talks in detail about the transformations in 
Perspective.

If you are new to drawing in perspective, you may find it tricky to distin-
guish the tools that follow the rules of perspective drawing and the ones that 
do not. For example, when you move an object toward the vanishing point 
of the plane it is lying on, you expect it to gradually reduce in size following 
certain rules of mathematics. Strictly speaking, Illustrator doesn’t provide 
a “perspective” mode in which you use all the regular tools and commands 
to draw and transform objects in perspective. Although you can draw flat 
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objects and bring them into perspective only when the grid is visible, you 
can move and scale perspective objects using the Perspective Selection tool 
whether the grid is visible or hidden.

Remember that drawing in perspective with the Line and Rectangle group 
tools is tied to grid visibility (and the currently active grid), whereas trans-
formation in perspective is independent of grid visibility and is tied to the 
Perspective Selection tool.

It is also important to understand that objects drawn or brought into per-
spective are no different from a flat instance of the same art type. For exam-
ple, the Control panel and the Layers panel show a rectangle in perspective 
as path. Thus it is tricky to determine whether an object is in perspective 
or not, especially if it has an irregular shape. This is where the perspective-
bounding box comes to the rescue.

Perspective Bounding Box
The only visual cue to indicate that an object is in perspective is the perspec-
tive bounding box, which is displayed when such an object is selected with 
the Perspective Selection tool. The perspective bounding box is an anno-
tation just like the regular bounding box, with eight handles for scaling. 
One can differentiate between regular and perspective bounding boxes by 
looking at the handles. On regular bounding boxes the handles are hollow 
( Figure 4.1a); on perspective bounding boxes they are filled with the same 
color as the plane color on which the object belongs (Figure 4.1b).

Figure 4.1 A regular 
bounding box (a) and a 
perspective bounding 
box (b).
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Additionally, a perspective bounding box displays the perspective center of 
the selection. When multiple objects are selected using the Perspective Selec-
tion tool, the centers of individual objects are not shown. The box responds 
to the Show/Hide Bounding Box command, just like a regular bounding 
box. If you need to scale the object in perspective, make sure the bounding 
box is not hidden, or you won’t be able to do so.

Insight into implementation

The perspective bounding box is basically the normal bounding box of the 
object in perspective. The normal bounding box of an object may or may not 
be same as the geometric (enclosing) box for that object. But the perspective 
bounding box always represents the geometric box of the object in perspec-
tive. That’s why the perspective bounding box is always a shape similar to 
the same size rectangle in perspective.

Figure 4.2 A perspective 
bounding box with multiple 
objects selected. The center 
point represents the center 
of the perspective bounding 
box, not that of any of the 
objects.
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Marquee Selection in Perspective
To facilitate the selection of multiple objects, Illustrator lets you drag out 
a marquee in perspective. With the Perspective Selection tool you always 
start drawing a rectangular marquee—regardless of which grid is currently 
active—that lets you select objects across different planes. Using the keys 1, 2, 
or 3 after you have started dragging lets you draw a marquee that resembles 
a rectangle in perspective and selects objects in one plane (Figure 4.3).

Transform Operations 
in Perspective
Using the Perspective Selection tool and the perspective bounding box, you 
can do the following:

1. Move the perspective object on its plane by dragging with Perspective 
Selection tool.

2. Change the perspective of an object (that is, move it to a different plane 
by pressing 1, 2, or 3 while dragging to choose the left vertical, horizon-
tal or the right vertical grids. Switching to a different plane works only if 
the grid is visible.

Figure 4.3 Using the 
Perspective Marquee by 
pressing 3 selects only the 
objects on the right vertical 
plane on the grid (the ellipse 
and the rounded rectangle). 
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3. Scale by dragging any of the perspective bounding box handles. There 
are eight of these handles available on the corners and edges. These 
let you scale the object in one, two, or both dimensions, like a normal 
bounding box.

4. Move the object on its plane using arrow keys. The perspective object 
moves on its plane when selected with the Perspective Selection tool and 
if the grid is visible. Both conditions must be true for the arrow keys to 
work in perspective. Movement in perspective using arrow keys is not 
tied to the Keyboard Increment value in the preferences. If snapping 
to the Perspective Grid is off, each stroke of an arrow key moves the 
selected object by 1/10th of the cell width. Shift plus the arrow key moves 
the object the width of a full cell. If Snap to Perspective Grid is on, the 
object moves the minimum distance that would cause any of its bound-
aries to snap to Perspective Grid lines.

5. Move the perspective object perpendicular to its plane by pressing 5 
while dragging. See Chapter 6, “The Third Dimension,” for details.

6. Invoke the Transform Again command to re-apply a transformation in 
perspective to the selected object.

TIP	 The Transform Again command offers very good flexibility for creating new shapes 
and duplicating them in perspective. If you want to draw multiple windows at equal dis-

tance from each other in perspective, you just draw one window and then replicate it once at the 
appropriate distance. The rest of the windows can be replicated using Transform Again 
(Figure	4.4).

NOTE	 You can scale, 
move an object either on 

or perpendicular to its plane, 
and also invoke Transform 
Again even if the grid is hidden.

Figure 4.4 The roadside 
trees have been dupli-
cated first using Option-
drag (Mac)/ Alt-drag 
(Windows) and then using 
the Transform Again com-
mand Command-D (Mac)/
Control-D(Windows).



ptg

ChaPTer 4: TransformaTions in PersPeCTive54

7. Use the Alt (Windows)/Option (Mac) key to create a copy of the object 
you are moving or to scale the object from its center. Use the Shift key 
to constrain a shape’s proportions (width to height) when scaling or 
to constrain movement along angles of 0 degrees (horizontal axis), 45 
degrees, or 90 degrees (vertical axis). Remember that the Shift keypress 
is not registered if you switch planes or apply perpendicular movement.

You cannot move or scale objects on different grid planes at the same time. 
The object where you do mouse-down determines the active grid. When you 
try to apply some transformation on a selection of objects across different 
planes on the grid, only objects on the active grid plane are transformed.

 If you select multiple objects by Shift-clicking, the plane of the last selected 
object becomes the active plane.

Snapping Aids in Perspective 
Transformations
When View > Perspective Grid > Snap to Grid is enabled, moving or scaling a 
selection snaps the edges of the perspective bounding box to the gridlines. 
The snapping tolerance is 1/5th of the cell width. This is not the same as the 
Snapping Tolerance value in the application preferences. Since the snapping 
tolerance in perspective is not an absolute distance, it effectively dimin-
ishes toward the vanishing point. If this were not so, any transformation 
of objects close to the vanishing points would result in unintentional snap-
ping. Movement by arrow keys with the Snap to Grid option enabled results 
in snapping of an edge of the perspective bounding box that is closest to a 
gridline. Snapping does not happen when you switch planes or apply per-
pendicular movement.

TIP	 When you select 
multiple objects across 

different planes, the perspec-
tive bounding box is displayed 
for the objects selected in the 
currently active plane. Only the 
anchors and edges of objects 
on other planes are highlighted 
to indicate they are selected.
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5Measurement Aids  
in Perspective

The Perspective Grid in Illustrator is suited not only to drawing street 
scenes and landscapes where you just use the gradual diminution of objects 
towards vanishing points to make the illustration realistic; the Perspec-
tive Grid is also tailor-made for technical artists, offering different units, 
scale, rulers, measurement readouts on the grid and on panels. This lets 
you project create detailed technical illustrations in perspective, such as the 
elevation of a building, interior of an office or apartment, sketch of an auto-
mobile, sections of machine-tools, and so on.

Units and Scale
Over the course of several releases, Illustrator users have become accus-
tomed to units such as point, pica, inch, centimeter, millimeter, and pixel. 
Points and picas originated with typography, and the Web brought in pixels. 
While these units serve graphic designers well, a technical artist needs a 
whole array of units, including kilometers, miles, yards, and feet. A surveyor 
may give a technical artist a blueprint in kilometers, and an interior decora-
tor may think in terms of feet. Illustrator, like most graphics applications, 
does not support these units. The workaround for these missing units is to 
use a scale; this can be anything between 1000000:1 (magnification) and 
1:1000000 (reduction), which you can set for the Perspective Grid.
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The Perspective Grid Preset options let you choose from the following units: 
point, inch, centimeter, or pixel. The default scale is 1:1. In addition to the 
following predefined ratios 1:5, 1:10, 1:20, 1: 50, 1:100, the Custom option 
allows you to define a scale from 1000000:1 to 1:1000000 (Figure 5.1).

Figure 5.1 Custom Scale dialog.

A scale of 1:50 implies that 1 unit on the grid represents 50 units in the real 
world. For example, selecting centimeter for the unit and a scale of 1:50 lets 
you represent 1 meter in real world as 2 centimeters on the grid along the 
True Height Line. You then need to enter the actual values of all your dis-
tances, lengths, and widths. Suppose you are creating a perspective view of 
a building as seen by an observer standing 180 cm tall and 10 meters away 
from that building. You will enter a Viewing Distance value of 10 x 100 = 1000 
(10 meters converted to centimeters, since you cannot enter the value in 
meters directly) and a Horizon Height value of 180.

If you sketch the building using the Line Segment tool and Rectangle tool 
dialogs, you need to again enter real-world values of the lengths and widths 
of your building blocks. To draw a window of 1 m x 1 m, enter both Width 
and Height equal to 100. If the “Gridline every” value in your preset is 100 
cm, the window in your drawing will exactly cover the area of a grid cell.

Here are some things to keep in mind when setting units and calculating 
dimensions:

1. The default unit of Line Group and Rectangle Group tools changes to 
the unit of the grid preset when grid is turned on and one of the planes 
is active.

2. When bringing flat objects into perspective, the reciprocal of the scale 
is applied. A 2 cm-by-2 cm flat square in the document becomes a 100 
cm-by-100 cm square in perspective.



ptg

units And sCAle 57

3. Changing the unit and scale in the Perspective Grid Preset options mul-
tiplies the current values of the “Gridline every,” Viewing Distance, and 
Horizon Height settings with appropriate conversion factors and the 
reciprocal of the scale; hence the values should be entered after select-
ing the unit and the scale.

All the other measurement aids mentioned above will also honor the 
selected unit and scale.

Figure 5.2 A 2 cm-by-2 cm 
flat square on the canvas is 
a 100 cm-by-100 cm square 
on the Perspective Grid when 
using a scale of 1:50.
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Rulers
The command View > Perspective Grid > Show Rulers turns on rulers along 
the edges of the two vertical planes. Note that in Figure 5.2 the unit is also 
shown beside the zero mark on the ruler. Thus the ruler is very useful for 
indicating the real-world size of each grid cell, which is derived from the 
“Gridline every” setting, unit, and scale chosen. To avoid clutter, the ruler 
divisions are not shown on the floor plane; remember that we cannot have 
different scales for the different planes, so each grid cell on the floor plane is 
also the same size.

Readouts
The readouts in perspective are tied to the Measurement Labels function-
ality of Smart Guides (Figure 5.3), and they display information about the 
current position of the cursor on the active plane as you mouse around 
holding down the Shift key. You can use this feature while using one of the 
drawing tools.

Figure 5.3 The 
Measurement readout.
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While drawing or scaling an object, the readout displays width and height of 
the object; while moving objects, it shows the x and y delta from the object’s 
original location. Note that the readouts also show the real-world dimen-
sions or position. In Figure 5.3, the current position of the cursor is on the 
left plane, 200 cm behind and 300 cm above the station point.

Info Panel
The Info panel displays information about the current position (x and y) of 
the cursor as you position it on the canvas while using either the Perspec-
tive Selection tool or one of the drawing tools. While drawing or scaling an 
object, the panel displays the width and height of the object; while moving 
objects the same W and H fields show the x and y delta from the object’s 
original location. Note that the Info panel shows the real-world dimensions 
for objects in perspective while moving or scaling them with the Perspective 
Selection tool regardless of grid visibility.

Transform and Control Panels
The Transform panel and the Transform options in the Control panel dis-
play information about the location (x and y) on the active plane of the 
selected reference point and the size (W and H) of the selected objects. The 
panels also allow you to further transform the selected objects using numer-
ical inputs in the relevant fields. You can also change the transformation 
reference point and lock the object’s proportions. 

Please note that these panels show (and allow editing of) the real-world 
dimensions of objects in perspective when the grid is visible. If the grid is 
hidden, they show the flat measurements of the objects derived from their 
2D geometry on the canvas. That is, the behavior of the Transform and 
Control panels is solely linked to the grid visibility and is independent of 
whether the regular Selection Tool or the Perspective Selection tool is used 
to select objects. Remember, the Rotate and Shear fields in the Transform 
panel have no relevance in perspective.
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6The Third  
Dimension

As you should realize by now, perspective drawing doesn’t involve the actual 
third dimension of the object in the scene. It is merely a simulation of the 
third dimension to get the closest possible representation of real-world 
objects on a flat surface.

If the capabilities of Illustrator were restricted to what we have discussed 
so far, they would not be much use in creating technical illustrations where 
accurate measurement is a must. So Illustrator has the concept of plane with 
offset. Here every object in perspective is assumed to belong to a flat sur-
face (plane) that lies at a certain distance from the viewer. This provides the 
third-dimension information for the object.

Illustrator provides the tools to create technically accurate objects in per-
spective that have depth or height information—the offset from the viewer. 
Automatic plane positioning, perpendicular movement of objects, and plane 
movement along with objects round out the perspective drawing tool set in 
Illustrator. This chapter discusses the concepts and toolkit available to create 
accurate measurements in the third dimension in Illustrator drawings. 

We know perspective drawing is a technique that artists employ to create 
spatial illusion. It is a means to depict the 3D world on a 2D surface—the 
canvas or the picture plane. The established techniques to draw linear 
perspective provide us with a way to conceive multiple planes at different 
depths or heights along the same dimension. Figure 6.1 shows a typical 3D 
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grid structure (in this case in one-point perspective). Note that it has four 
horizontal planes (green) at different heights; it also has four vertical planes 
(blue) at different positions.

Figure 6.1 Multiple planes 
in a perspective view, at  
different offset/heights.

Using a grid structure, an artist draws an elevation of a building in one-
point perspective (Figure 6.2) and creates a sense of depth which is evident 
in the way the wall with the window appears to be a few feet behind the wall 
with the door.

Figure 6.2 Elevation 
of a building drawn in 
perspective.
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Illustrator allows only one plane for every dimension in a perspective grid. 
The one-point perspective grid in Illustrator has one horizontal plane and 
one vertical plane, while the two- and three-point grids have one horizontal 
plane and two vertical planes each. Illustrator lets you pivot each grid plane 
on the corresponding vanishing point(s) to different heights or depths. This 
allows a technical artist to create a sense of depth in a scene like that in 
Figure 6.2. 

This concept of each object belonging to a flat, 2D plane is used extensively 
by Illustrator. There are multiple parallel planes at different depths; for 
example, the green planes in Figure 6.2 are at different heights from ground 
level. Each object in perspective belongs to one of these planes.

Insight into Implementation

illustrator doesn’t really introduce the third coordinate in the Ui or anywhere 
else. instead, to handle the true depth simulation, each object stores infor-
mation about the depth of the plane on which it belongs. This information 
is used later by individual transform operations and provides the feel of a 
third axis.

At times you will need to move an object in perspective toward its third 
dimension; for example, you might want to move an object on the left ver-
tical plane of two-point perspective so that it still vanishes toward the left 
vanishing point but become smaller in size, since that’s what would happen 
in the real world (Figure 6.3).

In addition to the ability to move a perspective object on its plane (the x and 
y axes), Illustrator allows users to move such objects along the axis perpen-
dicular to the plane (the z axis) honoring the rules of perspective. The appli-
cation lets you move or copy objects independently or in conjunction with its 
plane along the z-axis and also provides precise numerical controls to do the 
same. Such 3D capabilities are made possible by associating a z-coordinate or 
a plane location value with each object in perspective. This value is derived 
from the current depth or height of the plane.



ptg

perpenDiCUlar movemenT of objeCTs 63

Perpendicular Movement of Objects
What we have just described is called perpendicular movement of objects. 
Illustrator offers the following methods for perpendicular movement. 

Direct Manipulation of Objects
Press 5 (using the main keyboard, not the number pad) and drag with the 
Perspective Selection tool to move an object in perspective perpendicular to 
its plane. A black line from where you start to where you stop dragging pro-
vides a visual cue that the object is being moved perpendicularly to its plane 
(Figure 6.4). Use the Alt (Windows)/Option (Mac) key to copy the object.

Notice how the object in Figure 6.4 remains in perspective but diminishes 
in size toward the other vanishing point. This is what perpendicular move-
ment, aka movement through the plane, is.

Figure 6.3 Moving objects 
along the third dimension.
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Dragging Grid Planes
If the selected perspective object and the corresponding grid plane are at 
the same height or position, you can Shift-drag the Plane Control widget 
with the Perspective Selection tool to move the selected object and the plane 
together along the z axis. If no object is selected, all objects at the same depth 
as the plane will be moved. Similarly you can Alt (Windows)/Option (Mac)-
drag the Plane Control widget to move the plane and copy the selected or all 
objects perpendicular to the plane (Figure 6.5). Note that moving the plane 
this way shifts it parallel to its previous position.

One thing to remember is that whenever you move the grid plane while 
keeping the Shift key pressed, the plane will snap to grid cells; in other 
words, the movement would happen in an increment of the cell size.

Figure 6.4  Perpendicular 
movement of an object using 
the 5 key with the Perspective 
Selection tool.
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Using Numerical Inputs
Illustrator also allows you to enter the precise location of each plane in a 
dialog that is invoked when you double-click the Plane Control widget with 
the Perspective Selection tool. You can also quickly access this dialog while 
in any of perspective-aware tools by pressing Ctrl (Windows)/Cmd (Mac) and 
then double-clicking the Plane Control widget (Figure 6.6).

Figure 6.6 Precise perpen-
dicular movement of a plane 
and its objects using the Plane 
Movement dialog. 

The Plane Control dialog also provides three radio buttons that let you 
choose Do Not Move, Move All Objects, and Copy All Objects. Note that if an 
object lying on the current location of the plane is selected, Move All Objects 

Figure 6.5 The original 
object on the left vertical 
plane is duplicated when the 
plane is moved with the Alt/
Option key pressed. Pressing 
Shift instead of Alt/Option 
in this case would move 
the object to new position 
instead of creating a copy of 
the original object.
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and Copy All Objects change to Move Selected Objects and Copy Selected 
Objects, and transformations are applied only to the selected objects.

A location value of 0 for the horizontal grid or floor plane signifies that it is 
at ground level; a 0 value for the left and right vertical planes signifies that 
they currently pass through the station point. 

Move Plane to Match Object
Select an object in perspective and choose the Object > Perspective > Move 
Plane to Match Object command to move the corresponding plane to the 
object’s position. You can also do this via the object’s contextual menu. For 
example, say you have projected a plan on the horizontal grid and lifted it 
above ground level by pressing 5 and dragging the plan with the Perspec-
tive Selection tool. Now, if you want to draw additional objects at exactly the 
same height, you will need to lift the horizontal plane by selecting the pro-
jected objects and using the command.

Remember that the objects you draw may have exactly the same appear-
ance even if they are at different heights or positions, so that moving a plane 
to your desired position may seem immaterial. However, this does provide 
accurate measurements that you will enter in or read from the Control 
panel, Transform panel, or Info panel.

Drawing Modes and 
Perpendicular Movement
The new drawing modes in Illustrator CS5work pretty well with perspective 
transformations like perpendicular movement. At the point of transforma-
tion, the drawing mode determines whether the new object will be drawn 
on top of, below, or inside the previous object (Figure 6.7). This lets you 
quickly create shapes in perspective that are precisely placed. Drawings of 
lampposts, roadside trees, or parallel planes in perspective are all examples 
of this.

TIP  The depth value 
specified in the Plane 

Movement dialog above is 
absolute; that is, it represent  
an actual height or depth, not 
relative to another value. Also 
you must have noticed that if 
there is any scale factor value 
applied on the Perspective Grid 
then the same is used while  
values for the depth is taken/
shown in the plane movement 
dialog.
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Transformation of Multiple 
Objects at Different Offsets
Selecting objects lying on different planes was discussed in Chapter 4, 
“Transformations in Perspective.” We now understand that objects associ-
ated with the same grid plane may lie at different depths. When two or more 
objects on the same grid but lying at different depths are selected, multiple 
perspective bounding boxes are displayed: one for each plane at a different 
location that contains an object in the selection (Figure 6.8).

Such a grouping of objects can be moved or copied together either on their 
corresponding planes or perpendicular to their planes using the Perspec-
tive Selection tool and the relevant modifier keys—the objects maintain 
their relative distance. However, you cannot scale a group of objects like this 
together. You scale by dragging a handle on a bounding box, so only objects 
at the same depth are scaled together.

Figure 6.7 Using drawing 
modes with perpendicular 
movement. 
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Automatic Plane Positioning
You have learned to manipulate objects along the z axis (that is, perpendicu-
lar to an object’s plane). But what if you want to directly draw a shape at a 
depth based on another object? For example, say you have two faces of a box, 
and you want to draw the top face in the ground plane and at a height that 
matches the two existing faces (Figure 6.9).

Figure 6.8 When both the 
top and the bottom object 
are selected, each object 
moves in its own plane, and 
their relative positioning is 
retained.

Figure 6.9 To draw the 
top face of the box, you 
must get the height of either 
existing face.
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Similarly, you might want to place a 2D object at a depth based on another 
existing object in perspective. In other words, sometimes you need to infer 
(or deduce) the height or depth from other objects or planes in perspective.

For such workflows, Illustrator provides the flexibility to automatically move 
the grid planes to a position that is inferred from: 

• The anchor point of objects in perspective

• The intersection of two gridlines of some other grid plane

The Perspective Grid Options dialog that appears when you double-click 
either the Perspective Grid or the Perspective Selection tool lets you specify 
where to infer the plane position from; you can also deselect both check 
boxes to turn the feature off altogether (Figure 6.10).

Figure 6.10 Options 
for perspective tools.

With the Perspective Selection tool selected, if you mouse over the anchor of 
a perspective object or intersection points on grid plane, “anchor” or “inter-
sect” labels are displayed. Pressing the Shift key when these Smart Guides 
labels are displayed activates the automatic plane positioning (APP) mode. As 
soon as automatic plane positioning mode is invoked, all grid planes other 
than currently active one are hidden. 

In automatic plane positioning mode, the position for each of the planes 
in the grid is determined based on the inferred location—the anchor or 
intersect point. Switching the active plane in this automatic plane position-
ing mode will bring the newly active plane to the inferred position. You 
can draw a new object or bring a flat object into perspective at this inferred 
position.
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As soon as you are done drawing a new shape or bringing an object into 
perspective you exit the APP mode, and the positions and visibility of all the 
grid planes are restored to their pre-APP state.

The following examples explain how you can infer plane positions from 
either an anchor point or the intersection of gridlines. Suppose you want to 
draw a two-point perspective view of a cuboid. You first draw a vertical face 
of the cuboid; to draw the top face, you make the horizontal grid active. You 
can now infer the height to draw the top face from either of the two anchor 
points forming the top edge of the already drawn vertical face. Alternatively, 
you can infer height from the intersection of gridlines of a vertical plane, 
then enter the APP mode and then make the horizontal grid active. You need 
not draw the vertical face first, or at least need not use it as your reference. 
Using either or both techniques you can draw the six faces of the cuboid 
(Figure 6.11).

You can quickly infer position while in one of the shape tools by using Ctrl-
Shift (Windows)/ Cmd-Shift (Mac). Once the chosen height is inferred, then 
switching to any other plane would move that plane to the required height 
or depth and make other planes temporarily invisible (Figure 6.12).

Figure 6.11 When the 
“anchor” label is displayed, 
the height can be inferred 
from this location by press-
ing Shift with the Perspective 
Selection tool.

TIP  The automatic 
plane positioning mode 

works with anchor points of 
objects if Smart Guides are 
enabled; it works with intersec-
tion of gridlines if Snap to Grid 
is enabled.
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NOTE  Illustrator is not a 3D modeling application; and it does not let you rotate or revolve 
surfaces, nor does it allow different paints on front or back surfaces, even though perpen-

dicular movement may expose the front and back sides of an object.

Figure 6.12 Here we are 
drawing after inferring the 
height/depth from top edge 
of the front face of a cuboid. 
Notice how all other planes 
are invisible, and only floor 
is lifted to that height to 
provide accurate technical 
measurements by providing 
proper snapping.
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7Working with Text  
and Symbols in 
Perspective

The way Adobe Illustrator treats text and symbols in perspective is signifi-
cantly different from other simple object types. If you have been experi-
menting with text in perspective, you have probably discovered that you 
can’t type in text on the fly that appears to be in perspective, even if the grid 
is visible; you can’t create a text frame in perspective either. You may have 
a path in perspective, but the text you enter using the Type on Path feature 
does not appear in perspective. Instead, you have to create a regular text 
object and then bring it into perspective.

Because it’s not intuitive, this chapter explains how to work with text and 
symbols in perspective.

Suppose you have created an illustration of an office building for your client, 
who now wants to see his company logo in lights on the front of the building 
(Figure 7.1). Of course you can first type in the company name, create out-
lines, and then use the Perspective Selection tool to drag the outlined text 
into perspective. But when you do so you lose the ability to edit the text later.
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You will see how Illustrator lets you overcome this; but first let’s examine the 
challenges in working with symbols, which may also appear tricky at first. 
Suppose you create a symbol out of a rectangle already drawn in perspec-
tive. As you now need to move the symbol instance in perspective, you may 
be surprised to see the rectangle edges get misaligned with the grid even 
though you tried to move it with the Perspective Selection tool (Figures 7.2a 
and 7.2b).

Figure 7.2a Symbol created from 
a rectangle in perspective.

Figure 7.2b Moving the symbol 
with Perspective Selection tool.

What actually happens is that the symbol instance as an entity is reprojected 
or brought into perspective. A symbol definition has no notion of perspec-
tive, even if it contains artwork drawn in perspective, and symbol art is 
treated as regular 2D artwork until a symbol instance on canvas is brought 
into perspective with the Perspective Selection tool.

Figure 7.1 The company 
logo “Adobe” on the illustra-
tion of the office building.
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You may be wondering why you need to edit a symbol instance that you have 
brought into perspective. While to a new user symbols may seem like noth-
ing more than clip art, symbols in Illustrator allow users to efficiently man-
age artwork that is repeated in a document. Cody Walker and Steven Leduc, 
renowned technical artists and Illustrator prerelease testers, were creating 
an illustration of a German warship used in World War II. As the vessel was 
multistoried, Cody and Steven wanted to start by creating a symbol of the 
ship’s blueprint and use multiple instances of the symbol so that when they 
make minor edits in the ship’s blueprint, the change is reflected in all the 
stories of the ship.

Insight into Implementation

The ability to bring text and symbol instances into perspective and to retain 
their editability at the same time necessitated the introduction of a new 
plug-in group in illustrator CS5. To understand what a plug-in group is, think 
about the blends feature. a plug-in group contains “edit art” which you edit 
to get the final appearance that is the “result art.” in the case of blends, 
the objects you want to blend and the blend spline are the editable art. in 
the case of this new plug-in group, the edit art is dynamically generated by 
expanding the type object or symbol instance. note that expanding text 
creates type outlines, and expanding a symbol instance breaks it into its 
constituent objects, which get projected or transformed in perspective, to 
generate the result art. editability is retained by storing the live type object or 
symbol instance in the document dictionary.

Transforming Text and 
Symbols in Perspective
Now you know why it is important to be able to bring text and symbols into 
perspective and edit them freely; you also know something about how this 
functionality was implemented. Now you will see how to move, scale, and 
edit these special objects and how they interact with other editing tools in 
Illustrator.
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As we mentioned earlier, you cannot make text appear in perspective as 
you type it, regardless of whether the grid is visible or hidden. Likewise, 
you always place a flat symbol instance on your canvas whether you use 
the Symbols panel button or drag and drop from the Symbols panel onto 
your canvas.

With the Perspective Selection tool you can bring into perspective Point 
Type, Area Type, Type on Path, and a symbol instance. Once you have 
brought the text or symbol into perspective, you can transform it using 
the Perspective Selection tool and modifier keys—exactly the same way you 
would move, scale, or apply other perspective transformations to a simple 
rectangle. You can:

• Move the perspective object by dragging with the Perspective Selection 
tool

• Move it to a different plane by pressing 1, 2, or 3 while dragging

• Scale by dragging any of the bounding-box handles

• Move using the arrow keys

• Use the Control or Transform panel for precise movement or scaling 
with numeric values

• Move the perspective text or symbol perpendicular to the object’s plane 
by pressing the 5 key while dragging; see Chapter 6.

• Move or copy the plane either by using the grid plane controls or by 
invoking the precise plane positioning dialog; see Chapter 6.

For more on these techniques, also see Chapter 4, “Transformations in 
Perspective.”

Editing Text and Symbols 
in Perspective
To edit text or a symbol, do one of the following:

• Select the perspective text or symbol (notice the Control panel shows 
the Object Type as Perspective Object) and click the Edit Text or Edit 
Symbol button (Figure 7.3).

Note  The modifier 
keys Alt (Windows)/

Option (Mac), Shift, and Ctrl 
(Windows)/Command (Mac) 
work with the Perspective Selec-
tion tool the same way they do 
when you are moving and scal-
ing 2D artwork on the Illustra-
tor canvas with the regular 
Selection tool. The Transform 
Again command can also be 
used to re-apply a transforma-
tion in perspective to the 
selected object.
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Figure 7.3 The Control 
panel with a perspective text 
or symbol chosen.

• Select the perspective text or symbol and choose the command Object > 
Perspective > Edit Text or Edit Symbol.

• Double-click the perspective text or symbol with either the regular 
Selection tool or the Perspective Selection tool.

• Select the perspective object and use the Control panel button or the 
context menu command to enter Isolation mode.

• Edit the symbol by double-clicking it in the Symbols panel or from the 
panel’s fly-out menu.

Whichever editing method you choose, you actually are entering Isolation 
mode to edit the perspective object. If it is perspective text, as you enter Iso-
lation mode the whole text block and the Type tool are selected by default; at 
this point you can edit the original Type object—be it Point Type, Area Type, 
or Type on Path (Figure 7.4).

tIP  If you want to 
change an entire text 

block, start by overwriting 
existing text. If you try to delete 
the entire string of text and 
then enter new text, the per-
spective type object is deleted 
from the document, and you 
automatically exit Isolation 
mode.

Figure 7.4 Perspective text 
in edit mode.
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You can also apply all sorts of formatting, including character styles, glyphs, 
Open Type, paragraph styles and tabs, as you can with regular text. The 
appearance of the result art changes accordingly. You are not allowed to 
resize the type object or do any operation with the Selection tool or Direct 
Selection without expanding the perspective object. We will discuss expan-
sion of the plug-in group in the next section.

If the perspective object is a symbol, you enter the symbol-editing mode by 
confirming that you want to edit the symbol definition by clicking OK in the 
resulting dialog (Figure 7.5).

Figure 7.5 Dialog warning 
that the Symbol definition 
will be edited.

The only thing you need to keep in mind while working with symbols in 
perspective is that some art types are not supported in perspective even if 
they are supported as normal symbols—such as raster images, nonnative 
art, envelopes, legacy type, and gradient mesh. Symbols in perspective can-
not contain art with raster effects (which produce images when expanded, 
including the Rasterize effect, some of the Stylize effects, and the Photoshop 
Effects). Symbol Set is also not supported in perspective.

Once you are done formatting the text or editing the symbol definition, you 
can exit Isolation mode by clicking the gray bar that appears at the top of 
the document, by double-clicking the canvas, or by using the Exit Isolation 
Mode button in the Control panel or pressing the Esc key.

Expanding of Perspective 
Text and Symbol
We talked about plug-in groups earlier. Expanding a plug-in group creates 
new, individually editable objects that match the appearance of the result 
art, but you lose the edit art. For example, when you expand a blend you get 
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the original objects plus the blend steps, which become individually edit-
able; however, you can no longer edit the original objects or the blend spline 
to change the overall appearance of the art. Expanding perspective text 
creates a group of compound paths. Expanding a perspective symbol may 
create different objects depending on the symbol’s contents. In any case, the 
appearance of the result art is retained.

Perspective plug-in groups are expanded in several workflows where pre-
serving appearance is important: Suppose you created an illustration con-
sisting of perspective text and symbols, and you want to move it on the 
artboard to adjust the used space in your design. You naturally want to 
retain the appearance of the completed illustration in perspective. When-
ever you move objects with the Perspective Selection tool, their appearances 
basically change. Also, Illustrator does not let you move perspective objects 
you have drawn along with the grid. However, if you move a rectangle in 
perspective with the regular Selection tool, the rectangle retains its shape 
and size, although it becomes distorted with respect to the grid. But you 
cannot simply move a perspective plug-in group with the regular Selection 
tool without expanding it. As the result art’s appearance is a function of the 
edit art’s position on the grid, the plug-in group cannot be moved to any 
arbitrary location with respect to the grid and retain its original appearance. 
Illustrator expands perspective text or symbols whenever you try to move 
those objects with the regular Selection tool. If you attempt this, you will see 
the warning shown in Figure 7.6.

Figure 7.6 Warning to the 
user that the perspective 
object will be expanded.

Note that this dialog doesn’t have a Cancel button: It is intended to serve as 
a pointer for users. If you accidentally used the regular Selection tool and 
encountered this dialog, click OK and then choose Undo to get back the per-
spective plug-in group.

The idea of expanding has been extended to editing the plug-in group with 
all other tools and menu commands (such as Object > Transform) that are 
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not perspective aware. For example, if you edit an anchor point of such an 
object with the Direct Selection or Pen tool, perspective text and symbols are 
always expanded.

Copying and pasting perspective text and symbols using the simple Paste 
command also expands the plug-in group objects. Since the Paste command 
always pastes the clipboard contents in the center of the active window, 
there’s no guarantee that the pasted perspective plug-in group will be at 
the same position with respect to the grid. The object may even be pasted 
in another document which may have a different grid altogether. As the 
appearance of the result art depends on the grid parameters and the posi-
tion of the edit art with respect to the grid, the plug-in group is expanded in 
copy and paste operations so as to preserve appearance of the copied object. 
The Paste in Front, Paste in Back, and Paste in Place commands do not 
expand the plug-in art.

Editing the grid using different widgets or defining a different grid in a 
document also expands the perspective plug-in group objects to preserve 
appearance. The dialog shown in Figure 7.7 is there to educate the user; 
again, Cancel is not an option.

Figure 7.7 Grid change 
warning.

Note that moving the grid planes or adjusting the grid cell size and measure-
ments does not amount to changing the grid definition in the document; 
hence, perspective plug-in group objects are not expanded.

As a special case, perspective symbols are expanded when you edit the 
symbol definition and try to include art types not supported in perspec-
tive. While the symbol definition in the document does get updated, the 

tIP  If you are main-
taining a couple of dif-

ferent versions of your 
illustration in two documents, 
and you have defined identical 
grids (using the same preset, 
you may use the Paste in Front, 
Paste in Back, or Paste in Place 
commands to actually paste 
the perspective plug-in group 
without expanding. The Paste 
on All Artboards command also 
expands perspective text and 
symbols unless the object is 
being “pasted in place” as 
determined by the pasted 
object’s position on the canvas. 
Thus Paste on All Artboards in 
effect pastes the object as is on 
the artboard it has been copied 
from and expands the same on 
all other artboards.
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perspective symbol without the new contents is expanded to match its exist-
ing appearance. The dialog shown in Figure 7.8 is displayed.

Figure 7.8 This warning 
dialog appears when a 
symbol is edited to include 
art types not supported in 
perspective.

Vanishing Stroke Weight
You may have already started working on some perspective projects, and 
you might be puzzled as to why stroke weight does not get lighter as an 
object vanishes in perspective. We admit that would have been an excellent 
addition to the perspective drawing feature set, but there is a workaround. 
Perspective symbols let you make stroke weights vanish in perspective as 
shown in Figure 7.9. In this example we want to bring a rectangle with 
30-point stroke applied into perspective. To make the stroke weight appear 
to recede in perspective, do the following:

1.  Create a symbol out of the rectangle. Symbols provide the additional 
benefit of retaining a 2D version of your art.

2.  Scale the symbol instance a bit. Make sure that you do nonuniform scal-
ing of width and height; this in fact expands the rectangle stroke to a 
compound path behind the scenes. However, when you edit the symbol 
you can change the stroke weight of your artwork as desired.

3.  Bring the symbol into perspective with the Perspective Selection tool. 
Figure 7.9 shows how the vertical edge of the rectangle that is closer to 
the right vanishing point is apparently lighter than its opposite edge.
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Alternatively, you can first bring the symbol instance into perspective and 
then scale it with the Perspective Selection tool, which gives the same van-
ishing stroke weight effect. Note that scaling apparently changes the stroke 
weight of the rectangle in a symbol; for example, it may appear to have a 60- 
or 90-point stroke, as you are actually scaling up a compound path. So you 
have take care to make minute, nonuniform scaling adjustments to achieve 
this effect. In the example shown in Figure 7.9, we started with a rectangle 
with a 10-point stroke weight and used Object > Transform > Scale to scale 
the symbol by 300 percent horizontally and 300.001 percent vertically. This 
gives the appearance of 30-point stroke weight in the final artwork and fools 
Illustrator into nonuniform scaling to expand the stroke. Also note that 
expanding the stroke of the rectangle without creating a symbol would have 
given a similar result, but at the cost of further stroke-weight editability.

Figure 7.9 Receding 
stroke weight for objects in 
perspective.
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8Putting Things  
Together

Knowledge is useless until put into action, so this chapter is about using 
what you’ve learned in this book to draw some scenes in perspective. 

You will set up a perspective view and then use methods to create a nice-
looking perspective drawing. The example in this chapter uses most of the 
features described in the previous chapters. So let’s get to work and get our 
hands dirty.

There are three ways to create a drawing in perspective. Which one you 
choose depends on the kind of drawing you want to create:

• A drawing based on a single view that is based on the visual appear-
ance of the scene, focusing on accurate measurements of objects. The 
measurements take care of accurate size and relative position of the 
objects in the scene. For example you might draw a view of a building in 
perspective with information about the height, width of side walls, and 
other objects in the scene.

• A drawing based on a single view based on the visual appearance of a 
scene, but where precise measurements of the objects is not important. 
This method of drawing focuses primarily on the relative size and posi-
tioning of objects in the scene. For example, if you are drawing a per-
spective scene of railroad tracks, you may not care about the distance 
between the tracks, just the appearance of the tracks in perspective. 
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• Drawing using different views of an object, such as plan and eleva-
tion. In this kind of drawing the artist not only has different views but 
also accurate measurements and positions for the different objects in 
the scene. This entails drawing details very precisely and accurately.  
Here the perspective view is set up carefully, and the units and scale 
are selected with utmost care based on the objects to be drawn. This 
approach is appropriate for subjects such as a building interior or an 
automobile, for example.

Drawing Based on Visual 
Appearance and Measurements
Figure 8.1 shows a building (maybe a shopping mall) in two-point per-
spective. In this example we are starting with some basic measurements; 
although they aren’t required, they help keep the objects’ relative size and 
position accurate.

Figure 8.1 A two-point 
perspective scene of a 
building.
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1. Set up the Perspective Grid. The first and most basic step is to set up the 
appropriate perspective view in the document. In this case we are using 
two-point perspective. Create a new document and choose the default 
Two Point Perspective Grid by pressing Ctrl (Windows)/Cmd (Mac) 
-Shift-I or choose View > Perspective Grid > Show Grid.

2. Decide the units and scale to use. This step is equally important if you 
are interested in getting the right measurements, particularly if you are 
starting from a blueprint of the objects. Choosing the right scale factor 
lets you represent real-world objects in perspective accurately with ease. 
In this example, the following measurement information is available:

• Lamppost height: 8 feet

• Road width: 6 feet

• Building height: 25 feet

Other measurements may be available, but for now don’t worry about them. 
With these measurements in hand, you know it would be a good idea to use 
feet as the unit. Illustrator doesn’t allow feet as the unit, though; the next 
best option is inches. 

Now you can decide whether to draw a scaled up or scaled down version of 
the scene. In this example we are trying to draw a scaled down version of 
the real-world scene, which influences the scale factor we should choose. 
Ideally you would know the scale based on the scene being drawn. In this 
drawing we use a scale of 1:6; this means that at true height line, 1 inch in the 
artboard represents 6 inches in the real world.

To set the scale, choose View > Perspective Grid > Define Grid dialog, and 
change the units and scale value. You should also change the value of hori-
zon height to 72 inches (normal viewing height) and the view distance to 
something larger so that the vanishing points appear a little farther away. In 
this case, set it to 150 inches (these settings are shown in Figure 8.2). Notice 
that the “Gridline every” setting is also 6 inches. Basically, this is to set the 
square of 0.5 foot everywhere on the grid. The viewing angle has also been 
changed to 40 to give more emphasis to the right-side view of the scene.

Figure 8.3 shows the grid after we have specified different parameters.
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Figure 8.2 Perspective 
Grid settings.

Figure 8.3 Perspective 
Grid on canvas after setting 
different parameters.
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Drawing the Scene
Draw a simple rectangle with dimensions of 96 by 996 inches (8 by 80 feet) 
on the ground plane starting at the station point (Figure 8.4). As you start 
drawing the rectangle, the dimensions may not be precisely accurate—the 
readout may show a value slightly lower or higher than exactly 96 inches for 
the width. Don’t worry about it, though: Once the drawing is done you can 
enter the precise value in the Transform panel for the shape. If you do that, 
make sure to change the reference point to the bottom-right corner in the 
Control panel. Otherwise, the shape will reposition itself, and you’ll have to 
move it back to the station point location (where you want it to be).

For better organization of the content, we have renamed the layer Roads 
and this object Main-Road. You rename layers by clicking their names in the 
Layers panel.

Now move and create the next adjacent road, which is basically the sidewalk. 
To create this you need some more measurements. The sidewalk is about 6 
inches (or half a foot) above the main road and is about 4 feet wide. Since 
the surface representing the height of the sidewalk will vanish toward the 
right, you need to draw a rectangle in the right vertical plane. However, you 
need to ensure that it is drawn at the correct depth so the measurements 

Figure 8.4 Drawing the 
bottom of the sidewalk using 
the Rectangle tool.
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accurately represent the object in the real world. If measurements are not 
a concern, you can skip the automatic plane positioning instructions below 
and simply draw a rectangle in the right plane, joining the two ends of the 
main road.

Here’s how to create the sense of height for the sidewalk.

1. Zoom in on the starting point for the sidewalk, which is close to one of 
the edges of the main road.

2. Set the left vertical plane to be active, so you can infer the sidewalk’s 
height from the gridlines on that plane.

3. Move the mouse to the first gridline on left vertical plane, just above the 
point where Main-Road ends (Figure 8.5).

4. Press Ctrl-Shift (Windows)/Cmd-Shift (Mac) to switch to the to Perspec-
tive Selection tool temporarily and infer depth from that location.

5. Now draw a rectangle in the right vertical plane, joining the two ends of 
the main road. You can switch the active plane before or during draw-
ing by pressing the 3 key. When you switch the plane, the right vertical 
plane will be the only one visible; others temporarily become invisible, 
which helps you draw accurately. Let’s rename this rectangle Footpath-
height (Figure 8.6).

Figure 8.5 Using auto-
matic plane positioning 
to infer depth from a 
Perspective Grid line.
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To create the surface representing the sidewalk, you need to draw another 
rectangle at 6 inches above the main road and connecting to the surface rep-
resenting the height of the sidewalk.

To draw at 6 inches above the ground level, place the mouse at the anchor 
point and press Ctrl-Shift (Windows)/Cmd-Shift (Mac) again (Figure 8.7).

Figure 8.6 Drawing in 
automatic plane positioning 
mode.

Figure 8.7 Automatic 
plane positioning used to 
infer the depth from an 
already-drawn object in 
perspective.
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Make the ground plane active, then start drawing a rectangle from the point 
previously used for automatic plane positioning. Now draw the sidewalk 
to the end of the main road: 48 by 996 inches. To do this you can draw the 
shape approximately and then again use transform panel or control panel 
for accurate measurement. An alternative method is to use snapping with 
Perspective Grid lines and Perspective Construction Guide functionality. 
To do this while drawing this rectangle, move the mouse temporarily to the 
end location of the Footpath-height; this starts generating the construction 
guides from that point (Figures 8.8 and 8.9).

Let’s call this object Footpath-Top. Apply appropriate colors to these paths, 
and lock this layer to make sure you don’t modify the objects accidentally.

Figure 8.8 Hovering the 
mouse over the anchor point 
to start getting the construc-
tion guides.
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Creating the Walls
Before you move on to drawing the walls, make sure you create a new layer 
for them. You can do this from the Layers panel. The wall in the scene is 6 
feet high, and you have various options for drawing it. You can draw a flat 
rectangle with the required height to represent the wall, or you can draw 
a rectangular grid to give it a more realistic appearance. However, here we 
tried something with the symbols. Using different tools (Rectangle, simple 
lines, and the Pen tool) we have created a symbol with a kind of brick pat-
tern (Figure 8.10). We won’t go describe how to create this symbol—it’s not 
really the intent of this exercise, and we assume you know enough about 
Illustrator to create a symbol already.

The thing to note is the dimension of the symbol. Since you will create it in 
flat 2D space, you have to take its size into account. As mentioned in Chap-
ter 5, “Measurement Aids in Perspective,” while placing objects in perspec-
tive the reciprocal of the scale factor is applied to the object. In this case, if 
you create a symbol of 1 inch by 1 inch, it represents 6 by 6 inches of the real-
world object, in this case the wall. To make things simpler, create a symbol 
with dimensions of 6 by 6 inches in document coordinate system. This basi-
cally represents 36-by -36 inch wall segment in real world (or 3-by-3-foot-
square portion of the wall).

Figure 8.9 Drawing the 
top surface of the sidewalk 
using snap to grid and con-
struction guides.
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Figure 8.10 Using a symbol to show the brick pattern on the wall.

Now since you need to draw the wall exactly touching the side of footpath 
we have to use Automatic Plane Positioning again. 

1. Choose the Perspective Selection tool.

2. Move the mouse over one of the anchor points on the side of the foot-
path where you want the wall to be placed, and press Shift key to use 
automatic plane positioning (Figure 8.11).

3. Make sure that the right vertical plane is active, then drag the symbol 
instance using its bottom-left point for proper placement.

4. Drop it right at the anchor point that we used for automatic plane posi-
tioning above (Figure 8.12).
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Notice that the Info panel shows the dimension of the object as 36 by 36 
inches in perspective as described above.

Figure 8.11 Pressing Shift 
invokes automatic plane 
positioning, which causes the 
right vertical plane to move 
to the corresponding depth. 

Figure 8.12 Symbol 
instance placed at the cor-
rect depth.
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5. Now do a Shift-Alt-Drag (Windows)/Shift-Option-drag (Mac) using the 
Perspective Selection tool on this instance to create a duplicate of it 
exactly on top of it (Figure 8.13). You may want to hide the bounding 
box (View > Hide Bounding Box) temporarily for picking it from the bot-
tom left/right corner for proper placement, otherwise you will hit one of 
the perspective bounding box handles and the shape will scale instead 
of moving.

6. Select both of these symbol instances, and Alt/Option-Shift-drag, this 
time in a horizontal direction, toward the right vanishing point. Posi-
tion the copy right where the original wall segment ends.

7. After this step, keep the duplicate instance of the symbol selected and 
choose Object > Transform > Transform Again, or press Ctrl/Cmd-D. 
This makes more copies of this pattern in perspective. Keep doing this 
until you have the wall length you want (Figure 8.14).

Move all these symbols to a sublayer of the Walls layer and rename it Right 
Wall. On the left side, you want a segment of wall that ends 6 feet from the 
end of the sidewalk and a segment that is 4 feet back from that (Figure 8.15).

Figure 8.13 Duplicate 
the wall segment using 
Alt/Option-drag with the 
Perspective Selection tool. 
To constrain the movement, 
press Shift as well.
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Figure 8.15 The wall on 
left has two segments with 
different depths.

Figure 8.14 Use Transform 
Again to replicate the wall 
pattern until you get the 
required length of wall.
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Let’s draw the second wall first.

1. Place another instance of the symbol on the left vertical plane such that 
the bottom-right point of the symbol lines up with the sidewalk end-
point (Figure 8.16).

2. Choose Windows > Transform to open the Transform panel.

3. Keeping the newly placed instance selected, subtract 72 inches (6 feet) 
from the x location. This offsets the placed instance toward the left van-
ishing point (Figure 8.17).

Figure 8.16 Placing a sym-
bol instance to start the left 
wall segment.

Figure 8.17 Using the 
Transform panel to change 
the position of objects in 
perspective.
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4. Now use the Shift-Alt/Option-drag with the Perspective Selection tool 
create the rest of the wall, the same way you did for the right vanishing 
wall.

5. This portion of the wall needs some depth, so without selecting any 
objects, double-click the left plane movement widget using the Perspec-
tive Selection tool. This invokes the Plane Movement dialog. Specify a 
value of 36 inches (since the wall segment is to be at a depth of 4 feet), 
and make sure to check Move All Objects (Figure 8.18).

Figure 8.18 Specify the offset 
at which objects needs to be 
moved. 

6.	 Move this portion of wall to a new sublayer and name it Depth 
(Figure 8.19).

7. Now hide the Depth sublayer for the time being to create the other 
portion of wall that starts right at the sidewalk and connects with the 
right wall.

Figure 8.19 Creating a 
left vanishing wall in depth 
using the Plane Movement 
dialog.
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8. Using automatic plane positioning again, infer the depth from the 
corner of Footpath, then bring another instance of this symbol into 
perspective.

9. Use Alt/Option-drag and the Transform Again command to create the 
portion of the left wall that connects with right wall, as you did with the 
right vanishing wall.

10. Create another sublayer, named Normal, for the normal portion of the 
left vanishing wall.

11. Make sure the Normal sublayer is above the Depth sublayer in the layer 
order, so things appear correctly. Also, make sure Right Wall is above 
Left Wall in the layer order (Figure 8.20).

Before you proceed with the next component, you should finish the right 
wall. Unlock the Right Wall layer so you can draw on it.

Now put the Runner symbol on this wall. To find the Runner symbol, open 
the Logo Elements symbol library that is supplied with Illustrator CS5. You 
can open the Logo Elements library from the Symbol panel by choosing 
the Symbol Libraries Menu button in the panel: Choose Other Library and 
browse to the folder where Illustrator is installed, and look for /Presets/
[Application Location]/Symbols.

Figure 8.20 Walls after 
changing the layer order.
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You have two options for placing this symbol at the same depth as the right 
wall: You can either use automatic plane positioning or move the right plane 
to the same depth as the right wall, as follows:

1. Select one or more portions of wall in the Right Wall layer.

2. Right-click to get the context menu, and choose Perspective > Move 
Plane to Match Object (Figure 8.21).

This moves the right plane to the same depth as the right wall, until you 
change the plane position explicitly.

3. Drag an instance of the Runner symbol onto the document. 

4. Resize it to make it 6 inches by 6 inches. You can enter 6 in directly into 
the Control panel.

5. Place the symbol into perspective on the right wall using the Perspective 
Selection tool.

6. With the Perspective Selection tool, use Shift-Alt/Option-drag and 
Transform Again to duplicate the symbol as many times as you need.

7. Since the color of the Runner symbol is quite similar to that of the wall, 
it is difficult to see the runner on top of the wall. Using the Perspective 
Selection tool, double-click an instance of the Runner to enter symbol 
editing mode (Figure 8.22).

8. Change the color of the Runner symbol to white (Figure 8.23).

Figure 8.21 Using the 
Move Plane to Match Object 
command.
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Figure 8.22 Using symbol editing mode with the Perspective Selection tool.

Figure 8.23 Right wall 
after placing Runner 
symbol.
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Now you have finished both the walls, so you should lock the layers to avoid 
any accidental changes to these objects.

Creating the Building
Creating the building involves similar set of steps as drawing the road. You 
use the Rectangular Grid to draw the walls of the building.

1. Create a new layer named Building and move it below the Roads layer in 
the Layer panel.

2. Use automatic plane positioning by moving mouse to the anchor point 
located at the end of the right wall, joining the wall and sidewalk. Press 
Shift (with the Perspective Selection tool) or Ctrl/Cmd-Shift (if using the 
drawing tools).

Note	 You may see that the left vertical plane doesn’t really shift to the point that you 
chose for automatic plane positioning (Figure	8.24). This is a limitation of the application. 

The left/right vertical plane always has to remain within the canvas area, so if it is moved so that 
the plane movement widget starts falling outside the canvas area, the plane remains where it is 
and is not drawn at the new location. However, the drawing takes place at the correct depth.

Figure 8.24 A vertical 
plane may not reflect its 
chosen position in some 
cases.
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3. Draw a rectangular grid at this location in left vertical plane, keeping 
the size around 840 pixels wide by 480 pixels high (Figure 8.25).

If you cannot get it right using the mouse use the Control panel, keeping 
the required reference point.

Drawing the other face of the building (the one on the road) uses another 
technique: changing the object’s plane.

1. Make sure the right vertical plane is located at same depth as the right 
wall. If not, align them by selecting any portion of the right wall and 
then choosing Perspective > Move Plane to Match Object.

2. Using the Perspective Selection tool, pick this rectangular grid from the 
lower anchor point near the left vanishing point. You may want to hide 
the bounding box (View > Hide Bounding Box) temporarily for picking 
it correctly, otherwise you will hit one of the perspective bounding box 
handles, and the shape will scale instead of moving.

3. While dragging it, make the right vertical plane active. 

4. Without releasing the mouse, press Alt/Option to create a copy of the 
object in the right plane (Figure 8.26).

Figure 8.25 Using a rect-
angular grid to create the 
building.
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5. Change the color of the front face to make it more attractive. 

6. Change the depth of the left plane to match the back face of the build-
ing, by selecting the back face and then choosing Perspective > Move 
Plane to Match Object.

7. Decorate the back wall of the building by placing on it symbols from the 
symbol libraries in Illustrator CS5, such as Male Figure, Female Figure, 
and Flowers.

8. Create a simple text object containing the text City Life. 

9. Drag the text with the Perspective Selection tool to place it on the back 
face of the building. Scale and/or reposition the text object using the 
Perspective Selection tool.

10. Unlock the Roads layer and scale the road depth and footpath a little 
more to end where the building ends (Figure 8.27).

Figure 8.26 Duplicating 
an object from one plane to 
another to create the front 
face of the building.
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Figure 8.27 The building is drawn using a rectangular grid and a few symbols.

Drawing the Signpost
To draw a signpost, you can use another useful feature available for perspec-
tive drawing. Since it will be an irregular shape, you will use the Pen tool.

1. Create a new layer named Direction Board, and move it above Walls in the 
Layer panel.

2. With the Pen tool, start drawing the signpost at the start of the sidewalk.

3. As you draw the sign, you may wish to draw few straight lines in per-
spective, or maybe lines that directly meet at the vanishing point. To 
get these, move the mouse over the anchor point from where you need 
the lines.

Perspective construction guides appear (Figures 8.28a and 8.28b). 
These are generated in all three dimensions, toward both the vanishing 
points, along with a vertical guide.
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4. Once the shape is drawn, attach it to right plane by choosing Attach 
to Active Plane from the context menu or by choosing Object > 
Perspective > Attach to Active Plane (Figure 8.29).

5. Create a copy of this signpost using Alt/Option-drag with the Perspec-
tive Selection tool, but as you are dragging, make the left plane active 
(Figure 8.30).

Figure 8.28a Using per-
spective construction guides 
generated vertically.

Figure 8.28b Using per-
spective construction guides 
generated toward the van-
ishing point.
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6. Now use perpendicular movement to move this signpost close to the 
building. Start dragging this object using the Perspective Selection tool 
toward the end of the right vanishing point and press 5. Position it close 
to the end of the sidewalk.

You will see a gray line from the start to the end of the mouse pointer 
(Figure 8.31).

Figure 8.29 Using Attach 
to Active Plane to draw irreg-
ular shapes in Perspective.

Figure 8.30 Creating a 
copy of the signpost in the 
left vertical plane.
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7. Using the bounding box, reverse-scale the object so that it points toward 
the building. Also type some text and then bring it into perspective at 
the correct plane and depth, so that the signposts are complete (Figures 
8.32 and 8.33).

Figure 8.32 Reverse-scaling the 
signpost to change its direction.

Figure 8.33 A finished signpost 
at the beginning of the sidewalk.

Figure 8.31 Using perpen-
dicular movement to move 
the signpost close to the 
building.
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Drawing Lampposts in Perspective
Create a new layer named Lamp-Posts and make sure it is above Direction 
Board in the Layers panel. Now place a sample lamp object in the right verti-
cal plane at a depth of 0 inches. You can move the right plane to this depth 
using the Plane Movement dialog and enter the offset value as 0. The sample 
lamp art needs to be drawn in Illustrator. 

Use Alt/Option-drag to create a copy of the lamppost closer to the building, 
then replicate it with Transform Again (Ctrl/Cmd-D). To constrain the move-
ment, hold the Shift key down as well.

To duplicate these lampposts on the other side of the road, deselect all of 
them, then double-click the plane movement widget to invoke the Right 
Vanishing Plane dialog. Choose “Copy all objects” and in the resulting dialog 
enter an offset value of –96 inches (Figure 8.34). The negative value places 
the lamppost copies away from the left vanishing point. 

This duplicates the lampposts on the other side of the road (Figure 8.35).

Figure 8.34 Using the 
Plane Movement dialog to 
create a copy of the lamp-
post symbol.

Figure 8.35 Duplicated 
lampposts.
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After all this work, your drawing is finished, and all of it is in perspective 
(Figure 8.36). You can still select and modify any of the objects in a plane 
using the Perspective Selection tool.

We have omitted instructions for drawing minor objects such as the side-
walk top on the left side. But you should be able to finish these details using 
the skills you have already learned. With your newly acquired tools and 
skills, you should feel able to create any complex drawing in perspective.

Figure 8.36 The final drawing in perspective, with the Perspective Grid hidden.
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ASDK for Perspective 
Drawing 

In addition to the full set of tools for drawing in perspective provided by 
Adobe Illustrator, the program provides a rich set of Application Program-
ming Interfaces (APIs) in its Software Development Kit (SDK). These can be 
used by the third-party developers to create new and interesting plug-ins for 
working in perspective.

This appendix describes these APIs and points to keep in mind while devel-
oping using them.

There are two new public suites available for perspective functionality, the 
AIPerspectiveGridSuite and the AIPerspectiveTransformSuite.
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AIPerspectiveGridSuite
This suite includes the APIs that deal basically with the definition of the 
Perspective Grid in the document. Following are the APIs that make up this 
suite, including a brief description wherever appropriate.

AIBoolean (*IsGridVisible) ();

AIErr (*ShowGrid)(AIBoolean flag);

AIBoolean (*IsGridDefined)();

AIBoolean (*IsGridLocked)();

AIErr (*LockGrid)(AIBoolean flag);

AIBoolean (*IsGridStationPointLocked)();

AIErr (*LockGridStationPoint)(AIBoolean flag);

AIBoolean (*IsGridRulerVisible)();

AIErr (*ShowGridRuler)(AIBoolean flag);

AIBoolean (*IsSnapToGridEnabled)();

AIErr (*SnapToGrid)(AIBoolean flag);

AIErr (*GetGridSnapTolerance) (AIReal& snapTolerance);

AIErr (*SetDefaultPreset)();

AIErr (*ArtworkPointToPGPoint) (AIRealPoint& pt, 
GridPlaneType plane);

AIErr (*PGPointToArtworkPoint)(AIRealPoint& pt, 
GridPlaneType plane);

AIErr (*GetPGRulerUnit)(ADMUnits& unit);

AIErr (*SwitchActivePlane) ();

AIErr (*SetActivePlane) (GridPlaneType gridPlane);

AIErr (*GetActivePlane) (GridPlaneType& out_gridPlaneType);

AIErr (*GetActiveGridType) (PerspectiveGridType& 
out_gridType);

AIErr (*SwitchActivePlaneFromKB) ();
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Most of the APIs here are self-explanatory, but when you need more infor-
mation, look for the Adobe documentation of the API, or look for the header 
file “AIPerspectiveGrid.h” in the SDK.

One important aspect of working with APIs should be described in some 
detail: the coordinate system.

Coordinate System in Perspective
Perspective View/Grid has its own coordinate system. This is applicable to 
each plane given on the perspective. You can see this clearly by showing the 
Perspective Grid Rulers (choose View > Perspective Grid > Show Rulers). By 
default the ruler origin is located at the station point (see the Ruler Origin 
widget by switching to the Perspective Grid Tool). The ruler origin always 
remains in the ground plane; that is, for vertical planes in perspective, the 
measurements are always 0 at ground level.

The API ArtworkPointToPGPoint takes as input a point in the document 
coordinate system and then converts it to the PG coordinate system on the 
given perspective plane. 

Similarly PGPointToArtworkPointtakes as input a point in the PG coordinate 
system on the given plane and then converts it to the document coordinate 
system (Figure A.1).

Figure A.1 The anchor 
point position in the perspec-
tive coordinate system. 
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In Figure A.1, the value of the anchor point position is represented in the 
perspective coordinate system (0,0) belonging to the station point location. 
The point turns out to be at (30, 60). However, if the same point is checked 
after selecting No Plane Active (which effectively turns off the perspective) 
the point is reported in document coordinate system as (285, 577), as shown 
in Figure A.2.

What this means in terms of these two API(s) is:

AIRealPoint pt;
pt.h = 285.68;
pt.v = 577.96;
sAIPerspectiveGrid->ArtworkPointToPGPoint (pt, kGridLeftPlane)

// pt would now have values of –30, 60; that is, they are expressed in Perspec-
tive Grid coordinates.

Similarly, if you convert from the perspective coordinate system to flat coor-
dinates, the code appears as follows:

AIRealPoint pt;
pt.h = -30;
pt.v = 60;
sAIPerspectiveGrid->PGPointToArtworkPoint(pt, kGridLeftPlane)

Figure A.2 The anchor 
point in the document  
coordinate system.
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// pt now has values of 285.68, 577.96; that is, they are expressed in the art-
work coordinates.

Also note that these API(s) don’t have to do anything with the other API(s) 
GetOriginalPoint and GetPerspectivePoint available in AIPerspective-
TransformSuite. Those two API(s) don’t really convert the coordinate system 
of the given point; those are used for projection/reverse projection of point 
from/to Perspective view.

The API GetPGRulerUnit can be used to query the ruler unit of the Perspec-
tive Grid in the document; this obviously can be different than the docu-
ment ruler units used.

AIPerspectiveTransformSuite
The AIPerspectiveTransformSuite is what provides API(s) for transforming 
objects in perspective.

1.	 AIBoolean (*PutInPerspective) (AIArtHandle art, GridPlaneType 
activePlane, AIReal* planeOffset);

• This API puts a flat 2D object into perspective.

• The art object supplied itself is modified: Each anchor point of the 
art object is changed. Please be aware that this would re-execute 
any art style applied to the object.

• activePlane and the planeOffset basically specify the plane and 
position of the plane that the object has to be brought into. The 
planeOffset can be used here to put object at certain depth/height 
different from the current depth/height of that plane. Passing NULL 
for this would place the object at current depth/height of that plane 
in currently defined Perspective Grid.

2.	 AIBoolean (*GetOriginalArt)(AIArtHandle art);

• This API operates on a perspective object. The object in perspective 
would be at a specific location on the canvas. The API basically gives 
the original art object back; for example, if you apply it to a simple 
path of a trapezoid shape in perspective, this API would make that 
shape a rectangle (or the original art object). Again, it modifies the 
art object itself.
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• Note that after this API is done, the supplied art object’s position and 
size may be something unexpected—the object may lie outside the 
viewing/canvas area, and its size may be huge (covering the whole 
canvas). This is due to the fact that objects in perspective close to 
vanishing points are theoretically at an infinite distance from the 
viewer and their size also may be huge. For the same reason Adobe 
Illustrator doesn’t provide a direct way to get the original object 
from a perspective object back. 

3.	 AIBoolean (*GetOriginalPoint) (AIRealPoint& point, GridPlaneType 
activePlane, AIReal* planeOffset)

• Takes a point in perspective at the given plane and offset and 
changes it so that the point becomes the original point—that is, the 
one in the 2D canvas. This is basically reverse-projection of a point 
in perspective. Since the point doesn’t contain the information 
about the plane on which it belongs (unlike the art objects in per-
spective), you must specify the plane and offset explicitly. The point 
is supplied and remains in the document coordinate system only.

4.	 AIBoolean (*GetPerspectivePoint) (AIRealPoint& point, GridPlaneType 
activePlane, AIReal* planeOffset);

• Takes a point on a normal 2D canvas and projects it in perspective 
on the supplied plane at the given offset. This is equivalent to pro-
jection of a point in perspective. The point always remains in the 
document coordinate system.

5.	 AIBoolean (*ApplyTransformInPerspective) (AIArtHandle art,  
AIRealMatrix transform);

• Takes an art object handle in perspective and the transform 
matrix to apply on that art object. The transformation is applied in 
perspective.

• Internally this API gets the original art object corresponding to a 
given art handle, applies the transform matrix, and then projects 
it back into perspective. You can use this to apply transforma-
tions such as scale, move, rotate, and you will get the same effect in 
perspective. Remember that you might have to fix the transform 
matrix for any possible scale applied in the current Perspective Grid 
to get the required results.
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6.	 AIBoolean (*IsArtInPerspective) (AIArtHandle art);

7.	 AIErr (*ReleaseArtFromPerspective) (AIArtHandle art)

8.	 AIErr (*AttachArtToPerspective) (AIArtHandle art)

• This basically tells Illustrator to assume that the given art is in per-
spective. The art is assumed to be on the currently active plane on 
the currently defined Perspective Grid in the document.

9.	 AIBoolean (*CanAttachToPerspective) (AIArtHandle art);

10.	 AIBoolean (*CanReleaseFromPerspective) (AIArtHandle art);

11.	 AIBoolean (*IsPerspectivePluginObject) (AIArtHandle art);

• Text and symbols in perspective are treated differently than normal 
object types. For text or symbols in perspective, a new plug-in object 
is created. This API reports whether the given object is a perspective 
text/symbol or not.

12.	 AIErr (*GetTypeOfPerspectiveObject)(AIArtHandle art, ai::int16 &type);

13.	 AIBoolean (*IsPerspectiveObjectEditingOriginal)(AIArtHandle art);

14.	 AIErr (*PlaceArtInPerspective) (AIArtHandle art, AIRealPoint  startPoint, 
AIRealPoint endPoint, GridPlaneType plane);

• This is somewhat similar to putting an art object in perspective. The 
difference is this API provides finer control of the location of the 
object being placed. One can specify certain points of the normal 
object (such as the center point of a rectangle) to be located at a spe-
cific location in perspective (such as the intersection point of two 
other rectangles in perspective).

• Note that both start and end points are in the document coordinate 
system.

15.	 AIReal (*GetObjectPlaneOffset) (AIArtHandle art);

16.	 AIErr (*GetObjectPlane) (AIArtHandle art, GridPlaneType *objectPlane)

17.	 AIErr (*ConstrainPtsInPlane)(AIRealPoint& startPt, AIRealPoint& endPt, 
GridPlaneType& gridPlane, AIReal *offset);

• This constrains mouse movements to prevent drawing shapes that 
violate the rules of perspective. For example, creating a shape in the 
ground plane where part of the shape is above the horizon line is 
not possible because the shape belongs to a plane below the horizon 
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line. So if you wish to create some shapes based on two points, make 
sure to pass those points to this API to get the proper point (you can 
do this manually if you wish). This would also supply the height/
depth of the plane on which it is operating.

18.	 AIErr (*IsSelectionInMultipleOffset)(AIBoolean* isMultiOffsetSelection);

• There may be cases when objects across different plane offsets are 
selected, such as the bottom and top face of a cube in two-point  
perspective. This API is used for querying such scenarios.

19.	 AIErr (*GetOriginalArtBounds) (AIArtHandle art, ai::int32 flags,  
AIRealRect& bounds);

• This is one useful API for getting the real-world bounds of objects  
in perspective.
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BScripting Support for 
Perspective Drawing

Adobe Illustrator provides scripting capabilities to automate workflows. The 
scripting interface in Illustrator supports VBScript on Windows; AppleScript 
on Mac OS; and JavaScript, a platform-independent scripting language. This 
section describes the program’s scripting capabilities for perspective draw-
ing in detail. 

The SDK provides an API for working with the perspective grid program-
matically; in addition, the application provides a scripting interface that has 
some access to this API layer. A script can:

• Define a grid in a document using presets

• Show or hide the grid

• Get/Set the active plane

• Draw an object in perspective on the active plane

• Bring an object into perspective

The examples in this appendix are written in JavaScript. For a comprehen-
sive list of classes, objects, properties and methods in Illustrator’s object 
model, please refer to the Adobe Illustrator CS5 scripting reference for your 
scripting language, which you can download from http://www.adobe.com/
devnet/illustrator/scripting/.

http://www.adobe.com/devnet/illustrator/scripting/
http://www.adobe.com/devnet/illustrator/scripting/
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Define a Grid Using Presets
Illustrator provides default grid-parameter presets for one-point, two-point, 
and three-point perspectives. The presets are named [1P-NormalView], 
[2P-NormalView], and [3P-NormalView].

This script shows how to select a preset programmatically:

//Set the default one-point perspective preset 
app.activeDocument.selectPerspectivePreset(“[1P-Normal View]”);

//Set the default two-point perspective preset 
app.activeDocument.selectPerspectivePreset(“[2P-Normal View]”);

//Set the default three-point perspective preset 
app.activeDocument.selectPerspectivePreset(“[3P-Normal View]”);

You can create new perspective presets, export presets to files, and import 
presets from files. These scripts show how to export and import presets:

//Create a new document 
var mydoc = app.documents.add();

//Export perspective presets to a file 
var exportPresetFile = new File(«C:/scripting/PGPresetsExported») 
mydoc.exportPerspectiveGridPreset(exportPresetFile);

//Create a new document 
var mydoc = app.documents.add();

//Import perspective presets from a file 
var importPresetFile = new File(«C:/scripting/PGPresets») 
mydoc.importPerspectiveGridPreset(importPresetFile);

Show or Hide the Grid
This script shows or hides the Perspective Grid programmatically:

//Show the Perspective Grid defined in the document
app.activeDocument.showPerspectiveGrid();

//Hide the Perspective Grid defined in the document
mydoc.hidePerspectiveGrid();



ptg

Set the aCtive Plane 119

Set the Active Plane
The perspective grid plane types are:

• Left plane PerspectiveGridPlaneType.LEFTPLANE

• Right plane PerspectiveGridPlaneType.RIGHTPLANE

• Floor plane PerspectiveGridPlaneType.FLOORPLANE

• Invalid plane PerspectiveGridPlaneType.NOPLANE

For a one-point perspective grid, only the left and floor planes are valid.

This script sets the active perspective plane:

//Set left plane as the active plane 
app.activeDocument.setPerspectiveActivePlane(PerspectiveGridPlane 
➝ Type.LEFTPLANE);

//Set right plane as the active plane 
app.activeDocument.setPerspectiveActivePlane(PerspectiveGridPlane 
➝ Type.RIGHTPLANE);

//Set floor plane as the active plane
app.activeDocument.setPerspectiveActivePlane(PerspectiveGridPlane 
➝ Type.FLOORPLANE);

Draw on a Perspective Grid
When the Perspective Grid is on, drawing methods allow you to draw or 
operate on objects in perspective. This script creates a new document, shows 
a two-point perspective grid, and draws art objects on the left plane:

//Create a new document 
var mydoc = app.documents.add();

//Select the default two-point perspective preset 
mydoc.selectPerspectivePreset(“[2P-Normal View]”);

//Display the perspective grid defined in the document
mydoc.showPerspectiveGrid();

//Check if active plane is set to left; if not, set it to left 
if (mydoc.getPerspectiveActivePlane() != PerspectiveGridPlaneType. 
➝ LEFTPLANE) 
{ 
mydoc.setPerspectiveActivePlane(PerspectiveGridPlaneType. 
➝ LEFTPLANE); 
}
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//Draw rectangle in perspective, then resize to 200% and move 
var myrect = mydoc.pathItems.rectangle(30, -30, 30, 30, false); 
myrect.resize(200, 200, true, false, false, false, 100,  
➝ Transformation.TOPLEFT); 
myrect.translate (-420, 480);

//Draw ellipse in perspective 
var myellipse = mydoc.pathItems.ellipse(60, -60, 30, 30, false, 
➝ true);

//Draw rounded rectangle in perspective 
var myrrect = mydoc.pathItems.roundedRectangle(90, -90, 30,  
➝ 30, 10, 10, false);

//Draw polygon in perspective 
var mypoly = mydoc.pathItems.polygon(-105, 105, 15, 7, false);

//Draw star in perspective 
var mystar = mydoc.pathItems.star(-135, 135, 15, 10, 6, false);

//Draw path in perspective 
var newPath = mydoc.pathItems.add(); 
var lineList = new Array(4); 
lineList[0] = new Array(0,0); 
lineList[1] = new Array(60,0); 
lineList[2] = new Array(30,45); 
lineList[3] = new Array(90,110); 
newPath.setEntirePath(lineList);

Bring Objects into Perspective
If an art object is not in perspective, use the bringInPerspective() method 
to bring it into perspective and place it on a plane. This script creates a new 
document, draws art objects, and brings them into perspective on a three-
point perspective grid:

//Create a new document 
var mydoc = app.documents.add();

//Draw ellipse 
var myellipse = mydoc.pathItems.ellipse(60, -60, 30, 30, false, 
➝ true); 
//Draw polygon 
var mypoly = mydoc.pathItems.polygon(-105, 105, 15, 7, false);

//Draw star 
var mystar = mydoc.pathItems.star(-135, 135, 15, 10, 6, false);

//Select the default three-point perspective preset 
mydoc.selectPerspectivePreset(“[3P-Normal View]”);

//Display the perspective grid defined in the document
mydoc.showPerspectiveGrid();
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//Check if active plane is set to left; if not, set it to left 
if (mydoc.getPerspectiveActivePlane() != PerspectiveGridPlane 
➝ Type.LEFTPLANE) 
{ 
mydoc.setPerspectiveActivePlane(PerspectiveGridPlaneType. 
➝ LEFTPLANE); 
} 
//Bring the ellipse to the active plane (left plane) 
myellipse.bringInPerspective(-100,-100, PerspectiveGridPlane 
➝ Type.LEFTPLANE);

//Bring the polygon to the right plane 
mypoly.bringInPerspective(100,-100,PerspectiveGridPlaneType. 
➝ RIGHTPLANE);

//Bring the star to the floor plane
mystar.bringInPerspective(100,100,PerspectiveGridPlaneType. 
➝ FLOORPLANE);
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